# Contents

**Finding information about the printer**.........................................................11
   Finding information about the printer............................................................11

**Setting up the printer**..................................................................................13
   Checking the box contents..............................................................................13
   Installing another language control panel....................................................14
   Getting the printer ready to fax.................................................................14
   Connecting directly to a telephone wall jack............................................15
   Connecting to a telephone..........................................................................16
   Connecting to an answering machine....................................................17
   Connecting to a computer with a modem...............................................18

**Learning about the printer**.........................................................................21
   Understanding the parts of the printer.......................................................21
   Using the control panel..............................................................................23
   Customizing copy settings using the control panel....................................26
      Using the Copy Mode menu......................................................................26
      Using the Copy menu.............................................................................26
   Customizing scan settings using the control panel......................................27
      Using the Scan Destination menu..........................................................27
      Using the Scan menu............................................................................27
   Customizing fax settings using the control panel.........................................28
      Using the Fax Mode menu.......................................................................28
      Using the Fax menu...............................................................................28
   Customizing photo settings using the control panel...................................29
      Using the Photo Card Mode menu..........................................................29
      Using the Photo More Options menu.....................................................30
      Using the Photo Edit menu....................................................................31
      Using the Photo Print Settings menu.....................................................31

**Learning about the software**......................................................................33
   Using the printer software.........................................................................33
   Using the Productivity Suite.......................................................................33
Using the Productivity Suite buttons...................................................................................33
Using the All-In-One Center................................................................................................34
  Using the Maintain/Troubleshoot link................................................................................35
  Using the Scanning & Copying tab....................................................................................35
  Using the Saved Images tab............................................................................................36
Using the Solution Center..................................................................................................37
Using Print Properties.........................................................................................................38
  Save Settings menu.......................................................................................................39
  I Want To menu............................................................................................................39
  Options menu...............................................................................................................39
  Print Properties tabs....................................................................................................39
Using the Photo Editor........................................................................................................40
Using Fast Pics..................................................................................................................40
Using the Fax Setup Utility...............................................................................................40

Loading paper and original documents..............................................................................42
  Loading paper..................................................................................................................42
  Loading various paper types..........................................................................................44
  Loading original documents into the ADF......................................................................47
  Loading original documents on the scanner glass.......................................................48

Printing................................................................................................................................50
  Printing a document.......................................................................................................50
  Printing collated copies.................................................................................................50
  Printing cards................................................................................................................50
  Printing envelopes...........................................................................................................51
  Printing multiple pages on one sheet.............................................................................51
  Printing the last page first (reverse page order)............................................................52
  Printing transparencies...................................................................................................52
  Printing a banner..........................................................................................................53

Getting ready to print photos using memory devices......................................................54
  Inserting a memory card.................................................................................................54
  Inserting a flash drive....................................................................................................55
Browsing and selecting photos from a memory card or flash drive........................................56
Transferring digital photos from a memory card or flash drive...........................................57
  Transferring photos using the control panel........................................................................57
  Transferring photos using the computer............................................................................57
Using a PictBridge-enabled digital camera to control printing photos.................................58

**Printing photos using the control panel**.................................................................59
  Printing photos using the control panel...........................................................................59
  Printing a DPOF selection...............................................................................................60
Viewing a photo slide show on the control panel.............................................................60
Changing the default photo print settings..........................................................................60
Adjusting brightness.........................................................................................................61
Cropping photos using the control panel..........................................................................61

**Printing photos using the computer**.................................................................63
  Printing photos using the computer..............................................................................63
    Printing photos stored on the computer......................................................................63
    Printing photos stored on a memory device...............................................................63
  Printing borderless photos............................................................................................63
Browsing and selecting photos stored on the computer....................................................64
Creating and printing a scrapbook or album page.............................................................64
Adding text captions to a photo page................................................................................65

**Copying**.............................................................................................................66
  Making a copy..............................................................................................................66
    Making a copy using the control panel......................................................................66
    Making a copy using the software..............................................................................66
Repeating an image on one page using the control panel..................................................67
Collating copies.............................................................................................................67
    Collating copies using the control panel................................................................67
    Collating copies using the software.........................................................................68
Making borderless copies...............................................................................................68
    Making borderless copies using the control panel....................................................69
    Making borderless copies using the software.........................................................69
Enlarging or reducing an image.......................................................................................70
    Enlarging or reducing an image using the control panel.........................................70
    Enlarging or reducing an image using the software...............................................70
Scanning

Scanning multiple pages using the ADF
Scanning multiple pages using the scanner glass
Scanning to an application using the ADF
Scanning to an application using the scanner glass
Scanning a one-page document using the control panel
Scanning documents or images for e-mailing
Scanning documents or images to edit text
Scanning clear images from magazines or newspapers
Scanning documents or images to edit text
Scanning documents or images for e-mailing

Faxing

Sending a fax
Faxing a document using the control panel
Faxing a document using the software
Faxing a document using an application
Receiving a fax
Receiving a fax automatically
Receiving a fax with an answering machine
Receiving a fax manually
Setting the number of rings before receiving a fax automatically
Setting up Speed Dial
Setting up Speed Dial using the control panel
Setting up Speed Dial using the computer
Using Speed Dial
Sending a fax to a group (broadcast fax)
Sending a broadcast fax immediately
Sending a broadcast fax at a scheduled time
Using the Quick Dial buttons
Using the Phone Book
Faxing while listening to a call (On Hook Dial)
Dialing a fax number while behind a PBX
Setting the distinctive ring using the control panel
Forwarding faxes................................................................................................................85
Using Caller ID....................................................................................................................86
Blocking junk faxes.............................................................................................................86
Customizing settings using the Fax Setup Utility..............................................................87
Printing fax activity reports..............................................................................................88
Blocking unwanted changes to fax settings.................................................................89

Networking the printer.................................................................................................90
Installing network printers.........................................................................................90
    Shared printing.............................................................................................................90
    Direct IP printing.........................................................................................................91
Tips for installing a network printer.............................................................................92
    Assigning an IP address............................................................................................92
    Finding your MAC address....................................................................................92
    Configuring a network printer manually.................................................................92
    Finding a printer/print server located on remote subnets.........................................92
    Network troubleshooting tips................................................................................92

Maintaining the printer...............................................................................................94
Removing a used print cartridge..................................................................................94
Installing print cartridges.........................................................................................95
Aligning print cartridges............................................................................................96
    Aligning print cartridges using the control panel..................................................96
    Aligning the print cartridges using the Productivity Suite.......................................96
Cleaning the print cartridge nozzles..........................................................................97
    Cleaning the print cartridge nozzles using the control panel..................................97
    Cleaning the print cartridge nozzles using the Productivity Suite........................97
Wiping the print cartridge nozzles and contacts.......................................................98
Improving print quality.............................................................................................98
Preserving the print cartridges..................................................................................99
Cleaning the scanner glass.........................................................................................99
Ordering supplies.......................................................................................................100
Recycling Lexmark products....................................................................................100

Troubleshooting.......................................................................................................101
Setup troubleshooting...............................................................................................101
    Incorrect language appears on the display..........................................................101
    Power button is not lit...........................................................................................102
    Software does not install......................................................................................102
Page does not print.................................................................103
Cannot print from digital camera using PictBridge.................................104

Print troubleshooting........................................................................104
Improving print quality........................................................................104
Poor text and graphic quality...............................................................105
Poor quality at the edges of the page...................................................106
Printer does not print or respond.......................................................106
Print speed is slow.............................................................................106
Partial document or photo prints........................................................107

Copy troubleshooting..........................................................................107
Copier does not respond......................................................................107
Scanner unit does not close.................................................................107
Poor copy quality...............................................................................108
Partial document or photo copies........................................................108

Scan troubleshooting.........................................................................109
Scanner does not respond...................................................................109
Scanning takes too long or freezes the computer.................................109
Scan was not successful......................................................................110
Partial document or photo scans........................................................110
Cannot scan to an application..............................................................110
Cannot scan to a computer over a network..........................................110

Fax troubleshooting...........................................................................110
Cannot send or receive a fax...............................................................110
Can send but not receive faxes...........................................................112
Can receive but not send faxes............................................................113
Printer receives a blank fax.................................................................114
Received fax has poor print quality.....................................................114
Error message: Fax error....................................................................115
Error message: Fax mode unsupported.................................................115

Network troubleshooting....................................................................116
The printer to be configured does not appear in the list of printers found on your network......116
You cannot print to the network printer..............................................117
Network name does not appear in the list.............................................117

Jams and misfeeds troubleshooting.....................................................117
Paper jam in the printer......................................................................117
Paper jam in the ADF........................................................................118
Paper or specialty media misfeeds......................................................118
Printer does not feed paper, envelopes, or specialty media......................................................119
Banner paper jams..........................................................................................................................119

Memory card troubleshooting.........................................................................................................120
Memory card cannot be inserted..................................................................................................120
Nothing happens when a memory card is inserted.......................................................................120
Error messages on display............................................................................................................121

Error messages...........................................................................................................................121
Low Ink.....................................................................................................................................121
Paper Jam....................................................................................................................................121
Cartridge Error.............................................................................................................................121
Carrier Jam................................................................................................................................122
Error: 2200...................................................................................................................................122
Paper Out......................................................................................................................................123
Cartridge Missing........................................................................................................................123
Alignment Error............................................................................................................................123
Photo Mode: problem reading memory card..............................................................................124
Photo Mode: second memory card detected................................................................................124
Photo Mode: no images found.......................................................................................................124
~filename.jpg file appears...........................................................................................................124
Card format.................................................................................................................................124
DPOF Error: no images found.......................................................................................................124
DPOF Error: photo larger than paper size..................................................................................125
Sepia Warning...............................................................................................................................125
No Computer...............................................................................................................................125

Removing and reinstalling the software.....................................................................................125

Notices.........................................................................................................................................126

Index..........................................................................................................................................132
## Finding information about the printer

### Setup sheet

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>Setup</em> sheet gives you instructions for setting up hardware and software.</td>
<td>You can find this document in the printer box or on the Lexmark Web site.</td>
</tr>
</tbody>
</table>

### User's Guide

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>User's Guide</em> gives you instructions for using the printer and other information such as: • Maintenance  • Troubleshooting  • Safety</td>
<td>You can find this document on the Lexmark Web site.  When you install the printer software, the <em>User's Guide</em> may also be installed. 1. Click Start → Programs or All Programs → Lexmark 8300 Series.  2. Click User's Guide.</td>
</tr>
</tbody>
</table>

### CD

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CD contains drivers, software, and publication files. The CD installs the Help system on your computer if your printer connects to a computer.</td>
<td>You can find this CD in the printer box. See the <em>Setup</em> sheet for installation instructions.</td>
</tr>
</tbody>
</table>

### Help

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Help gives you instructions for using the software if your printer connects to a computer.</td>
<td>While in any Lexmark software program, click Help, Tips → Help, or Help → Help Topics.</td>
</tr>
</tbody>
</table>

### Lexmark Solution Center

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Lexmark Solution Center software is included on your CD if your printer connects to a computer. It installs with the other software.</td>
<td>To access the Lexmark Solution Center:  1. Click Start → Programs or All Programs → Lexmark 8300 Series.  2. Select Lexmark Solution Center.</td>
</tr>
</tbody>
</table>
### Readme file

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td>This file contains late-breaking information about the printer and software</td>
<td>To access the Readme file:</td>
</tr>
<tr>
<td>that does not appear in other documentation, as well as information specific</td>
<td>1 Click Start → Programs or All Programs → Lexmark 8300 Series.</td>
</tr>
<tr>
<td>to your operating system.</td>
<td>2 Select Readme.</td>
</tr>
</tbody>
</table>

### Web site

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> All paths for the Web site are subject to change.</td>
<td>1 Go to the Web site.</td>
</tr>
<tr>
<td></td>
<td>2 Select a country from the drop-down list in the upper-left corner of the</td>
</tr>
<tr>
<td></td>
<td>page.</td>
</tr>
<tr>
<td></td>
<td>3 Select the link for the information you need.</td>
</tr>
</tbody>
</table>

Record the following information (located on the store receipt and the back of the printer), and have it ready when you contact us so that we may serve you faster:

- Machine Type number:
- Serial number:
- Date purchased:
- Store where purchased:
### Setting up the printer

### Checking the box contents

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Black print cartridge</td>
<td>Cartridges to be installed into the printer.</td>
</tr>
<tr>
<td>2 Color print cartridge</td>
<td>Note: Cartridge combinations vary depending on the product purchased.</td>
</tr>
<tr>
<td>3 Telephone cord</td>
<td>Attaches to the EXT port at the back of the printer.</td>
</tr>
<tr>
<td>4 Power supply cord</td>
<td>Attaches to the power supply port located at the back of the printer.</td>
</tr>
<tr>
<td>5 Telephone line adapter</td>
<td>Connects to the telephone line and the answering machine, telephone, or other telecommunications equipment. Note: The telephone line adapter is not shipped to all countries and regions.</td>
</tr>
<tr>
<td>6 Setup sheet</td>
<td>Instructions on setting up printer hardware and software, and information on setup troubleshooting.</td>
</tr>
<tr>
<td>7 Installation software CD</td>
<td>Installation software for the printer. Also includes the printer software Help. Note: Installing the printer software also installs the Help.</td>
</tr>
<tr>
<td>8 User’s Guide or Setup Solutions</td>
<td>Printed booklet that serves as a guide.</td>
</tr>
</tbody>
</table>
Installing another language control panel

These instructions apply only if you received one or more additional language control panels with the printer.

1. Lift and remove the control panel (if one is installed).

2. Choose the correct control panel for your language.

3. Align the clips on the control panel with the holes on the printer, and then press down.

Getting the printer ready to fax

You can connect the printer with equipment such as a telephone, an answering machine, or a computer modem. If problems occur, see “Setup troubleshooting” on page 101.

Note: The printer is an analog device that works best when directly connected to the wall jack. Other devices (such as a telephone or answering machine) can be successfully attached to pass through the printer, as described in the setup steps. If you want a digital connection such as ISDN, DSL, or ADSL, a third-party device (such as a DSL filter) is required.

You do not need to attach the printer to a computer, but you do need to connect it to a telephone line to send and receive faxes.

You can connect the printer to other equipment. See the following table to determine the best way to set up the printer.

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Benefits</th>
<th>See this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The printer</td>
<td>Send and receive faxes without using a computer.</td>
<td>“Connecting directly to a telephone wall jack” on page 15</td>
</tr>
<tr>
<td>• A telephone cord</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Connecting directly to a telephone wall jack

Connect the printer directly to a telephone wall jack to make copies or send and receive faxes without using a computer.

1. Make sure you have a telephone cord and a telephone wall jack.

2. Connect one end of the telephone cord into the LINE port of the printer.

3. Connect the other end of the telephone cord into an active telephone wall jack.

**Note:** For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.
Connecting to a telephone

Connect a telephone to the printer to use the fax line as a normal telephone line. Then set up the printer wherever your telephone is located to make copies or send and receive faxes without using a computer.

1. Make sure you have the following:
   - A telephone
   - Two telephone cords
   - A telephone wall jack

2. Connect one telephone cord to the LINE port of the printer, and then plug it into an active telephone wall jack.

3. Remove the protective plug from the EXT port of the printer.
4 Connect the other telephone cord to a telephone, and then plug it into the EXT port of the printer.

**Note:** For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.

**Connecting to an answering machine**

Connect an answering machine to the printer to receive both incoming voice messages and faxes.

1 Make sure you have the following:
   - A telephone
   - An answering machine
   - Three telephone cords
   - A telephone wall jack

2 Connect one telephone cord into the LINE port of the printer, and then plug it into an active telephone wall jack.
3 Remove the protective plug from the EXT port of the printer.

4 Connect a second telephone cord from the telephone to the answering machine.

5 Connect a third telephone cord from the answering machine to the EXT port of the printer.

Note: For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.

Connecting to a computer with a modem

Connect the printer to a computer with a modem to send faxes from the software application.

1 Make sure you have the following:
   • A telephone
   • A computer with a modem
   • Three telephone cords
   • A telephone wall jack
2 Connect a telephone cord into the LINE port \( \text{\textbullet} \) of the printer, and then plug it into an active telephone wall jack.

3 Remove the protective plug from the EXT port \( \text{\textbullet} \) of the printer.

4 Connect a second telephone cord from the telephone to the computer modem.
5 Connect a third telephone cord from the computer modem to the EXT port of the printer.

**Note:** For more information on connecting the printer to telecommunications equipment, see the additional setup instructions that came with the printer. Setup steps may vary depending on your country.
Learning about the printer

Understanding the parts of the printer

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Automatic Document Feeder (ADF)</td>
<td>Scan, copy, or fax multiple-page letter, legal, and A4 size documents.</td>
</tr>
<tr>
<td>2 ADF input tray</td>
<td>Load original documents in the ADF. Recommended for scanning, copying, or faxing multiple-page documents.</td>
</tr>
<tr>
<td>3 ADF exit tray</td>
<td>Pick up your original document after it has gone through the ADF.</td>
</tr>
<tr>
<td>4 Top cover</td>
<td>Access the scanner glass.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The scanner glass is recommended for card stock, photos, and delicate or unusually sized originals that cannot be fed through the ADF.</td>
</tr>
<tr>
<td>5 Memory card slots</td>
<td>Insert a memory card.</td>
</tr>
<tr>
<td>6 PictBridge port</td>
<td>Connect a PictBridge-enabled digital camera or a flash drive to the printer.</td>
</tr>
<tr>
<td>7 Paper tray</td>
<td>Load paper.</td>
</tr>
<tr>
<td>8 Paper exit tray</td>
<td>Stack paper as it exits.</td>
</tr>
<tr>
<td>Use the</td>
<td>To</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>9 Control panel</td>
<td>Operate the printer. For more information, see “Using the control panel” on page 23.</td>
</tr>
<tr>
<td>10 Scanner unit</td>
<td>Access the print cartridges.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
</table>
| 1 EXT port | Connect additional devices, such as a data/fax modem, telephone, or answering machine to the printer.  
**Note:** Remove the plug to access the port. |
<p>| 2 Power supply port | Connect the printer to a power source. |
| 3 Rear access door | Remove paper jams. |
| 4 USB port | Connect the printer to a computer using a USB cable. |</p>
<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
</table>
| **5** LINE port | Connect the printer to an active telephone line to send and receive faxes. The printer must be connected to this telephone line to receive incoming fax calls.  
**Note:** Do not connect additional devices to the LINE port, and do not connect a DSL (digital subscriber line), ISDN (integrated services digital network), or cable modem to the printer. |

### Using the control panel

The display shows:
- All-In-One status
- Messages
- Menus

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> Quick Dial buttons (1–5)</td>
<td>Access any of the five programmed Speed Dial numbers.</td>
</tr>
</tbody>
</table>
| **2** Copy Mode | Access the copy menus and make copies.  
**Note:** The mode is selected when the button light is on. |
| **3** Scan Mode | Access the scan menus and scan documents.  
**Note:** The mode is selected when the button light is on. |
| **4** Fax Mode | Access the fax menus and send faxes.  
**Note:** The mode is selected when the button light is on. |
<p>| <strong>5</strong> Photo Card | Access the photo card menus. You can preview photos stored on a memory card or flash drive, edit the photos, and print them. |</p>
<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Fax Auto Answer</td>
</tr>
<tr>
<td></td>
<td>Answer all incoming calls when the button light is on. <strong>Note:</strong> For information on setting the number of rings before the machine will answer incoming calls, see “Receiving a fax automatically” on page 78.</td>
</tr>
<tr>
<td>7</td>
<td>Redial / Pause</td>
</tr>
</tbody>
</table>
|       | • In Fax mode, redial the last number entered.  
|       | • Insert a three-second pause in the number to be dialed to wait for an outside line or get through an automated answering system. Enter a pause only when you have already begun entering the number. |
| 8     | Phone Book |
|       | Access any of the programmed Speed Dial numbers (1–89) or Group Dial numbers (90-99). |

![Diagram](image.png)

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>➣</td>
</tr>
</tbody>
</table>
|       | • Decrease a number.  
|       | • Scroll through options on the display.  
|       | • When cropping a photo, move the selected crop area to the left. |
| 2     | ▲ |
|       | • Increase a number.  
|       | • Scroll through menus or options on the display.  
|       | • When cropping a photo, move the selected crop area up. |
| 3     | ✔ |
|       | Choose the option that appears on the display, or save settings. In Photo Card mode, select or deselect a photo. |
| 4     | ➤ |
|       | • Increase a number.  
|       | • Scroll through options on the display.  
|       | • When cropping a photo, move the selected crop area to the right. |
| 5     | ◀ |
|       | • Decrease a number.  
|       | • Scroll through menus or options on the display.  
<p>|       | • When cropping a photo, move the selected crop area down. |</p>
<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
</table>
| 6     | - Cancel a scan, copy, or print job in progress.  
      | - Clear a fax number or end a fax transmission and return the display to the fax default.  
      | - Exit a menu.  
      | - Clear current settings or error messages, and return to default settings. |
| 7     | Display a control panel menu or submenu. |
| 8     | - Return to the previous submenu.  
      | - Save the settings in a submenu and return to the previous menu. |

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A keypad number or symbol</td>
</tr>
</tbody>
</table>
|       | **In Fax mode:**  
      | - Enter fax numbers.  
      | - Navigate an automated answering system.  
      | - Select letters when creating a Speed Dial list.  
      | - Type numbers to enter or edit the date and time shown on the display.  
|       | **In Copy mode:** Select the number of copies you want to make.  
|       | **In Photo Card mode:** Select the number of photos you want to print. |
| 2     | Start Color  
      | Start a color copy, scan, or photo job, depending on which mode is selected. |
| 3     | Start Black  
      | Start a black-and-white copy, scan, fax, or photo job, depending on which mode is selected. |
| 4     | Power  
      | - Turn the printer on and off.  
      | - Stop the print, copy, fax, or scan process. |
Customizing copy settings using the control panel

Using the Copy Mode menu

To access and navigate the Copy Mode menu:

1. From the control panel, press **Copy Mode**.

2. Press ▲ or ▼ repeatedly until the menu option you want is highlighted.

3. Press ◀ or ▶ repeatedly until the setting you want is highlighted.

4. Press ✓ to save the setting.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies</td>
<td>Specify how many copies to print.</td>
</tr>
<tr>
<td>Enlarge</td>
<td>Specify the percentage for enlarging or reducing an image copy.</td>
</tr>
<tr>
<td>Lighter/Darker</td>
<td>Lighten or darken a copy.</td>
</tr>
<tr>
<td>Quality</td>
<td>Choose a print quality.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Specify the size of the paper loaded.</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Specify the type of paper loaded.</td>
</tr>
<tr>
<td>Repeat (per page)</td>
<td>Choose how many copies of an image to print on a page.</td>
</tr>
<tr>
<td>Collate</td>
<td>Collate copies as they exit.</td>
</tr>
<tr>
<td>N-Up</td>
<td>Choose how many pages to print on a page.</td>
</tr>
<tr>
<td>Content</td>
<td>Specify the type of original document loaded on the scanner glass.</td>
</tr>
<tr>
<td>Scan Size</td>
<td>Specify the size of the original document loaded on the scanner glass.</td>
</tr>
</tbody>
</table>

Using the Copy menu

To access and navigate the Copy menu:

1. From the control panel, press **Copy Mode**.

2. Press ◀.

3. Press ▲ or ▼ repeatedly until the menu option you want is highlighted.

4. Press ✓.
### Use this | To
---|---
Copy Print Preview | Preview the image to be printed on the display.  
**Note:** This submenu is not available when you are using the ADF.

| Maintenance | • View ink levels.  
| | • Clean cartridges.  
| | • Align cartridges.  
| | • Print a test page.

| Device Defaults | Modify the default settings.

---

### Customizing scan settings using the control panel

#### Using the Scan Destination menu

To access and navigate the Scan Destination menu:

1. From the control panel, press **Scan Mode**.
2. Press ▲ or ▼ repeatedly until the scan destination you want is highlighted.
3. Press ✓.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipboard</td>
<td>Scan to the clipboard.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Scan to e-mail.</td>
</tr>
<tr>
<td>File</td>
<td>Scan to a file.</td>
</tr>
<tr>
<td>An application</td>
<td>Scan to the application you select.</td>
</tr>
</tbody>
</table>

**Note:** The applications listed correspond to the applications installed on the computer.

#### Using the Scan menu

To access and navigate the Scan menu:

1. From the control panel, press **Scan Mode**.
2. Press 📊.
3. Press ▲ or ▼ repeatedly until the menu item you want is highlighted.
   - Press ◀ or ▶ repeatedly until the option you want is highlighted.
   - Press ✓ to open a submenu, and then press ▲ or ▼ repeatedly until the option you want is highlighted.
4. Press ✓ to select the setting, or press ◀ to save the setting and exit the menu.
<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>Specify a scan resolution.</td>
</tr>
<tr>
<td>Scan Area</td>
<td>Specify the size of the area to be scanned.</td>
</tr>
<tr>
<td>Preview Scan</td>
<td>Preview the scanned image on the display.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>• View ink levels.</td>
</tr>
<tr>
<td></td>
<td>• Clean cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Align cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
<tr>
<td>Device Defaults</td>
<td>Customize printer settings.</td>
</tr>
</tbody>
</table>

**Customizing fax settings using the control panel**

**Using the Fax Mode menu**

To access and navigate the Fax Mode menu:

1. From the control panel, press **Fax Mode**.

2. Enter a number in the text entry box, or press ▲ or ▼ repeatedly until the menu option you want is highlighted.

3. Press √ to select this menu, or enter the available submenus.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text entry box</td>
<td>Enter the number to which you want to send a fax.</td>
</tr>
<tr>
<td>Enter Another Number</td>
<td>Enter another number to which you want to send a fax.</td>
</tr>
<tr>
<td>Add From Phone Book</td>
<td>Send a fax to a number from the phone book and customize phone book settings.</td>
</tr>
<tr>
<td>Add From Redial History</td>
<td>Send a fax to, or view, previously dialed numbers.</td>
</tr>
</tbody>
</table>

**Using the Fax menu**

To access and navigate the Fax menu:

1. From the control panel, press **Fax Mode**.

2. Press  

3. Press ▲ or ▼ repeatedly until the menu option you want is highlighted.

4. Press √ to select this menu or enter the available submenus.

5. Press ◄ or ► to scroll through options.

6. Press ◁ to save your setting and return to Fax mode.
<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay Sending Fax</td>
<td>Enter a specific time to send a fax.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Make sure the date and time are entered correctly before setting a specific time to send a fax.</td>
</tr>
<tr>
<td>On Hook Dial</td>
<td>Dial a telephone number while listening to the call through a speaker on the printer. This is useful when you must navigate an automated answering system before sending your fax.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For more information, see “Faxing while listening to a call (On Hook Dial)” on page 84.</td>
</tr>
<tr>
<td>Quality</td>
<td>Choose a print quality for sending faxes.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Lighten or darken a fax.</td>
</tr>
<tr>
<td>History and Reports</td>
<td>View and print fax history reports.</td>
</tr>
<tr>
<td>Ringing and Answering</td>
<td>Modify ringing and answering options.</td>
</tr>
<tr>
<td>Fax Printing</td>
<td>Specify fax printing options.</td>
</tr>
<tr>
<td>Dialing and Sending</td>
<td>Specify the fax dialing and sending options.</td>
</tr>
<tr>
<td>Junk Fax Blocking</td>
<td>Block faxes from the numbers you specify.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>• View ink levels.</td>
</tr>
<tr>
<td></td>
<td>• Clean cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Align cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
<tr>
<td>Device Defaults</td>
<td>Modify the default settings.</td>
</tr>
<tr>
<td>Block Host Settings</td>
<td>Block unwanted changes to fax settings.</td>
</tr>
<tr>
<td>Print Fax Settings List</td>
<td>Print a list of the current fax settings.</td>
</tr>
</tbody>
</table>

**Customizing photo settings using the control panel**

**Using the Photo Card Mode menu**

To access and navigate the Photo Card Mode menu:

1. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

2. Press ▲ or ▼ repeatedly until the menu option you want is highlighted.

3. Follow the instructions on the display to navigate the menu option.
<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse and Print Photos</td>
<td>Browse through photos stored on a memory card or flash drive, preview selected photos, and print.</td>
</tr>
<tr>
<td>Print Camera Selections</td>
<td>Print photos using the camera selections in a DPOF file. Note: This submenu only appears if there is a DPOF file on your memory card or flash drive.</td>
</tr>
<tr>
<td>Print All Photos</td>
<td>Print all photos stored on a memory card or flash drive.</td>
</tr>
<tr>
<td>Save to Computer</td>
<td>Save photos stored on a memory card or flash drive to the computer.</td>
</tr>
<tr>
<td>View Slide Show</td>
<td>View a slide show of the photos stored on a memory card or flash drive.</td>
</tr>
<tr>
<td>Print New Photos</td>
<td>Print only the photos most recently stored on a memory card or flash drive.</td>
</tr>
<tr>
<td>Change Default Settings</td>
<td>Change the default photo print settings.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>• View ink levels.</td>
</tr>
<tr>
<td></td>
<td>• Clean cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Align cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
</tbody>
</table>

**Using the Photo More Options menu**

To access the Photo More Options menu:

- When browsing through photos to print:
  1. Press † to select a photo.
  2. Press ❘.

- When previewing photos for printing, press ❘.

To navigate the menu:

1. Press ▲ or ▼ repeatedly until the menu option you want is highlighted.

2. Follow the instructions on the display.
**Using the Photo Edit menu**

To access and navigate the Photo Edit menu:

1. From the Photo More Options menu, make sure **Edit Photo** is highlighted.

2. Press √.

3. Press ▲ or ▼ repeatedly until the menu option you want is highlighted.

4. Press √ to select an option or save a setting.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Lighten or darken an image.</td>
</tr>
<tr>
<td>Crop</td>
<td>Crop an image.</td>
</tr>
<tr>
<td>Auto Image Enhance</td>
<td>Improve the quality of printed photos.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The enhanced image will not appear on the display.</td>
</tr>
<tr>
<td>Red Eye</td>
<td>Reduce the red eye effect in photos.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The red eye reduction will not appear on the display.</td>
</tr>
<tr>
<td>Colorized Effect</td>
<td>Apply color effects to the image before printing. You can choose from:</td>
</tr>
<tr>
<td></td>
<td>• Sepia</td>
</tr>
<tr>
<td></td>
<td>• Antique Brown</td>
</tr>
<tr>
<td></td>
<td>• Antique Gray</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotate the image 90 degrees clockwise or counter-clockwise.</td>
</tr>
</tbody>
</table>

**Using the Photo Print Settings menu**

To access and navigate the Photo Print Settings menu:

1. From the Photo Card Mode menu, press ▲ or ▼ repeatedly until **Change Default Settings** is highlighted.

2. Press √.

3. Press ▲ or ▼ repeatedly until the menu option you want is highlighted.

4. Press ◀ or ▶ repeatedly until the setting you want is highlighted.

5. Press √ to save the setting.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>Select the size of paper loaded in the tray.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default is 4x6 in..</td>
</tr>
<tr>
<td>Photo Size</td>
<td>Select the size of the photo to be printed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default is 4x6 in..</td>
</tr>
<tr>
<td><strong>Use this</strong></td>
<td><strong>To</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Layout</td>
<td>Select a page layout for printed photos.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default is <em>Automatic</em>.</td>
</tr>
<tr>
<td>Print Quality</td>
<td>Select a print quality.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default is <em>Normal</em>.</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Select the type of paper loaded in the paper tray.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The default is <em>Auto Detect</em>.</td>
</tr>
</tbody>
</table>
Learning about the software

Using the printer software

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Productivity Suite</td>
<td>Open the component necessary for you to complete a task.</td>
</tr>
<tr>
<td>The All-In-One Center</td>
<td>Scan, copy, print, and fax.</td>
</tr>
<tr>
<td>The Solution Center</td>
<td>Find troubleshooting, maintenance, and cartridge ordering information.</td>
</tr>
<tr>
<td>Print Properties</td>
<td>Select the best print settings for the document you are printing.</td>
</tr>
<tr>
<td>The Photo Editor</td>
<td>Edit photos and graphics.</td>
</tr>
<tr>
<td>Fast Pics</td>
<td>Transfer photos from a memory card, flash drive, or PictBridge-enabled digital camera to the computer.</td>
</tr>
<tr>
<td>The Fax Setup Utility</td>
<td>Adjust fax settings.</td>
</tr>
</tbody>
</table>

Using the Productivity Suite

Use the Productivity Suite to open the correct component for the task you want to complete.

To open the Productivity Suite software, use one of these methods:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
<th>Method 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the desktop, double-click the Productivity Suite icon.</td>
<td>1 Click Start → Programs or All Programs → Lexmark 8300 Series. 2 Select Productivity Suite.</td>
<td>Right-click the system tray icon, and then select Productivity Suite.</td>
</tr>
</tbody>
</table>

Using the Productivity Suite buttons

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder Icon" /></td>
<td>Manage Documents</td>
<td>Organize, search for, or print documents. Send documents to other people, or open them with various programs.</td>
</tr>
<tr>
<td><img src="image" alt="Photo Icon" /></td>
<td>Manage Photos</td>
<td>Organize or print photos in various layouts. Send photos to other people, or open them with various programs.</td>
</tr>
<tr>
<td>Click</td>
<td>To</td>
<td>Details</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Visit us Online</td>
<td>Visit our Web site.</td>
</tr>
<tr>
<td></td>
<td>Scan</td>
<td>Scan a photo or document.</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Copy a photo or document with options to enlarge, reduce, or change other features.</td>
</tr>
<tr>
<td></td>
<td>Fax</td>
<td>Send a fax or change fax settings.</td>
</tr>
<tr>
<td></td>
<td>Attach to E-mail</td>
<td>E-mail documents or photos which are scanned or saved on the computer.</td>
</tr>
<tr>
<td></td>
<td>Scan &amp; Edit Text (OCR)</td>
<td>Scan a document to a word processor to edit the text using Optical Character Recognition (OCR).</td>
</tr>
<tr>
<td></td>
<td>Scan to PDF</td>
<td>Scan a document and save it on your computer as a PDF.</td>
</tr>
</tbody>
</table>

**Using the All-In-One Center**

Use the All-In-One Center software to scan, copy, and fax documents, or to print saved photos.
To open the All-In-One Center, use one of these methods:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
</table>
| From the desktop, double-click the **Productivity Suite** icon, and then click **Scan** or **Copy**. | 1. Click **Start** → **Programs** or **All Programs** → **Lexmark 8300 Series**.  
2. Select **All-In-One Center**. |

**Using the Maintain/Troubleshoot link**

The Maintain/Troubleshoot link provides you with direct links to the Solution Center and the Fax Setup Utility.

1. Click **Start** → **Programs** or **All Programs** → **Lexmark 8300 Series**.

2. Select **All-In-One Center**.

3. Click **Maintain/Troubleshoot**.

4. Select from these topics:
   - Maintain or fix quality problems
   - Troubleshoot problems
   - Device status and ink levels
   - More printing ideas and how to's
   - Contact information
   - Advanced (Skin, voice, and communication options)
   - View the software version and copyright information
   - Display the Fax Setup Utility

**Using the Scanning & Copying tab**

Use the Scanning & Copying tab to perform scanning and copying tasks, to select a task from Productivity Tools, or to preview an image.

<table>
<thead>
<tr>
<th>From this section</th>
<th>You can</th>
</tr>
</thead>
</table>
| **Scan**          | • Select a program to send a scanned image to.  
                    • Select what type of image is being scanned.  
                    • Select the scan quality.  
                    **Note:** Click **See More Scan Settings** to view all settings. |
<table>
<thead>
<tr>
<th>From this section</th>
<th>You can</th>
</tr>
</thead>
</table>
| Copy             | - Select the quantity and color of copies.  
|                  | - Select a quality setting for copies.  
|                  | - Select a blank paper size.  
|                  | - Select the size of the original document.  
|                  | - Lighten or darken copies.  
|                  | - Enlarge or reduce copies.  
|                  | **Note:** Click **See More Copy Settings** to view all settings. |
| Productivity Tools | - Print an album page with various photo sizes.  
|                  | - Enlarge or reduce an image.  
|                  | - Print an image as a multiple-page poster.  
|                  | - Fax an image or document.  
|                  | - E-mail an image or document.  
|                  | - Edit text found in a scanned document with OCR.  
|                  | - Modify an image with a photo editor. |
| Preview          | - Select a region of the previewed image to scan or copy.  
|                  | - View an image of what will be printed or copied. |

**Note:** For more information about using the Scanning & Copying tab, click **Help** in the top center of the screen.

**Using the Saved Images tab**

Use the Saved Images tab to perform tasks with images that are saved on the computer.

<table>
<thead>
<tr>
<th>From this section</th>
<th>You can</th>
</tr>
</thead>
</table>
| Preview          | - Show or create folders.  
|                  | - Preview and select images.  
|                  | - Rename, delete, or edit selected images. |
| Open With        | Select where to send the saved images. |
| Photo Prints     | Click **Show More Printing Options** to view and adjust the print settings. You can:  
|                  | - Select the quantity and color of copies.  
|                  | - Select a quality setting for copies.  
|                  | - Lighten or darken copies.  
|                  | - Enlarge or reduce copies.  
|                  | **Note:** Click **Next** to select and print photos in standard sizes. |
**From this section** | **You can**
---|---
Productivity Tools | • Print an album page with various photo sizes.
• Enlarge or reduce an image.
• Print an image as a multiple-page poster.
• Fax an image or document.
• E-mail an image or document.
• Edit text found in a scanned document with OCR.
• Modify an image with a photo editor.

**Note:** For more information about using the Saved Images tab, click Help in the top center of the screen.

**Using the Solution Center**

The Solution Center provides help, as well as information about the printer status and ink levels.

To open the Solution Center, use one of these methods:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
<th>Method 3</th>
<th>Method 4</th>
</tr>
</thead>
</table>
| From the desktop, double-click the **Productivity Suite** icon, and then click the **Maintain/Troubleshoot** button. | **1** Click **Start** → **Programs** or **All Programs** → **Lexmark 8300 Series**.  
**2** Select **Solution Center**. | From the All-In-One Center, click the **Maintain/Troubleshoot** link located in the top center, and then click one of the available topics. | Right-click the system tray icon, and then select **Solution Center**. |

The Solution Center consists of six tabs:

<table>
<thead>
<tr>
<th>From this tab</th>
<th>You can</th>
</tr>
</thead>
</table>
| **Printer Status (Main dialog)** | • View the status of the printer. For example, while printing, the status of the printer is **Busy Printing**.  
• View the type of paper detected in the printer.  
• View the ink levels of the print cartridges. |
| **How To** | Learn how to:  
• Scan, copy, fax, and print.  
• Find and change settings.  
• Use basic features.  
• Print projects such as banners, photos, envelopes, cards, iron-on transfers, and transparencies.  
• Find the printable **User’s Guide**. |
<table>
<thead>
<tr>
<th>From this tab</th>
<th>You can</th>
</tr>
</thead>
</table>
| Troubleshooting | • Learn tips about the current status.  
• Solve printer problems. |
| Maintenance | • Install a print cartridge.  
**Note:** Wait until scanning is complete before installing new print cartridges.  
• View shopping options for new cartridges.  
• Print a test page.  
• Clean to fix horizontal streaks.  
• Align to fix blurry edges.  
• Troubleshoot other ink problems. |
| Contact Information | Learn how to contact us by telephone, e-mail, or on the World Wide Web. |
| Advanced | • Change the appearance of the Printing Status window.  
• Turn printing voice notification on or off.  
• Change network printing settings.  
• Share information with us regarding how you use the printer.  
• Obtain software version information. |

**Note:** For more information, click **Help** in the lower right corner of the screen.

### Using Print Properties

Print Properties is the software that controls the printing function when the printer is connected to a computer. You can change the settings in Print Properties based on the type of project you want to create. You can open Print Properties from almost any program:

1. With a document open, click **File ➔ Print**.
2. From the Print dialog, click **Properties, Preferences, Options**, or **Setup**.
**Save Settings menu**

From the “Save Settings” menu, you can name and save the current Print Properties settings for future use. You can save up to five custom settings.

**I Want To menu**

The “I Want To” menu contains a variety of task wizards (printing a photo, an envelope, a banner, a poster, or printing on both sides of the paper) to help you select the correct print settings for a project.

**Options menu**

Use the “Options” menu to make changes to the Quality Options, Layout Options, and Printing Status Options settings. For more information on these settings, open the tab dialog from the menu, and then click the Help button on the dialog.

The “Options” menu also provides direct links to different parts of the Solution Center as well as software version information.

**Print Properties tabs**

All of the print settings are on the three main tabs of the Print Properties software: Quality/Copies, Paper Setup, and Print Layout.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality/Copies</td>
<td>• Select a Quality/Speed setting.</td>
</tr>
<tr>
<td></td>
<td>• Select a Paper Type.</td>
</tr>
<tr>
<td></td>
<td>• Customize how the printer prints several copies of a single print job: collated or normal.</td>
</tr>
<tr>
<td></td>
<td>• Choose Automatic Image Sharpening.</td>
</tr>
<tr>
<td></td>
<td>• Choose to print color images in black and white.</td>
</tr>
<tr>
<td></td>
<td>• Choose to have the last page printed first.</td>
</tr>
<tr>
<td>Paper Setup</td>
<td>• Specify the size of paper loaded.</td>
</tr>
<tr>
<td></td>
<td>• Select the orientation of the document on the printed page: portrait or landscape.</td>
</tr>
</tbody>
</table>
### Tab | Options
---|---
Print Layout | • Select the layout you want to print.  
• Choose to print on both sides of the paper, and select a duplexing preference.

**Note:** For more information about these settings, right-click a setting on the screen, and then select What’s This?

### Using the Photo Editor

Use the Photo Editor software to edit graphics or photos.

1. Click **Start → Programs** or **All Programs → Lexmark 8300 Series**.
2. Select **Photo Editor**.
3. Click **File → Open** to select the image you want to edit.
4. Edit the image with the available tools.

**Notes:**
- You can edit only one image at a time.
- Move the mouse pointer over the tool for a description.

5. Click **File → Save as**.
6. Enter a file name and file type, and then click **Save**.

### Using Fast Pics

Use the Fast Pics software to save or print photos from a digital camera memory card or flash drive.

To open Fast Pics, insert a digital camera memory card or flash drive into the printer. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

With Fast Pics, you can:
- Print photos using a computer. For more information, see “Printing photos stored on a memory device” on page 63.
- Save photos from a memory card or flash drive to the computer. For more information, see “Transferring digital photos from a memory card or flash drive” on page 57.

### Using the Fax Setup Utility

Use this utility to adjust how faxes are sent and received. When you save the settings, they apply to every fax you send or receive. You can also use this utility to create and edit the Speed Dial list.

1. From the desktop, double-click the **Productivity Suite** icon.
2. Click **Fax**.
3. Click **Manage fax history or All-In-One fax settings**.
For a list of options available from the Fax Setup Utility, see “Customizing settings using the Fax Setup Utility” on page 87.
Loading paper and original documents

Loading paper

1 Make sure:
   - You use paper designed for inkjet printers.
   - The paper is not used or damaged.
   - If you are using specialty paper, you follow the instructions that came with it.
   - You do not force paper into the printer.

2 Lift the paper exit tray, and extend the center paper guide.

3 Insert paper into the paper tray.
4 Adjust the paper guides to rest against the left, right, and bottom edges of the paper.

5 Lower the paper exit tray.

6 Extend the paper exit tray stop to catch the paper as it exits.
## Loading various paper types

<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 sheets of plain paper</td>
<td>The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>50 sheets of coated paper</td>
<td>• The glossy or coated side of the paper faces down.</td>
</tr>
<tr>
<td>50 sheets of premium paper</td>
<td>• The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>50 sheets of photo paper</td>
<td><strong>Note:</strong> Photos require more drying time. Remove each photo as it exits, and allow it to dry to avoid ink smudging.</td>
</tr>
<tr>
<td>50 sheets of glossy paper</td>
<td>• The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>100 sheets of letterhead paper</td>
<td>• The letterhead side of the paper faces down.</td>
</tr>
<tr>
<td></td>
<td>• The top of the letterhead feeds into the printer first.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>10 envelopes</td>
<td>• You do not load envelopes with holes, perforations, cutouts, deep embossing, metal clasps, metal folding bars, string ties, or exposed adhesive flaps into the printer.</td>
</tr>
<tr>
<td></td>
<td>• The print side of the envelopes faces down with the flap to the left as shown.</td>
</tr>
<tr>
<td></td>
<td>• You print the envelopes in landscape orientation.</td>
</tr>
<tr>
<td></td>
<td>• You select the correct envelope size. If the exact envelope size is not listed, select the next biggest size. Set the left and right margins so that the envelope text will be correctly positioned on the envelope.</td>
</tr>
<tr>
<td></td>
<td>• You load the envelopes vertically and all the way to the back of the paper tray.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the left, right, and bottom edges of the envelopes.</td>
</tr>
<tr>
<td>Load up to</td>
<td>Make sure</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>25 sheets of labels</td>
<td>• You use full label sheets. Partial sheets (with areas exposed by missing labels) may cause labels to peel off during printing, resulting in a paper jam.</td>
</tr>
<tr>
<td></td>
<td>• The print side of the labels faces down.</td>
</tr>
<tr>
<td></td>
<td>• The top of the labels feeds into the printer first.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the left, right, and bottom edges of the label sheets.</td>
</tr>
<tr>
<td>50 transparencies</td>
<td>• The rough side of the transparencies faces down.</td>
</tr>
<tr>
<td></td>
<td>• You remove any paper backing sheets from the transparencies before loading.</td>
</tr>
<tr>
<td></td>
<td>• If the transparencies have a removable strip, each strip faces down toward the paper tray.</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the left, right, and bottom edges of the transparencies.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Transparencies require more drying time. Remove each transparency as it exits, and allow it to dry to avoid ink smudging.</td>
</tr>
<tr>
<td>100 sheets of custom size paper</td>
<td>• The print side of the paper faces down.</td>
</tr>
<tr>
<td></td>
<td>• The paper size fits within these dimensions:</td>
</tr>
<tr>
<td></td>
<td>Width:</td>
</tr>
<tr>
<td></td>
<td>– 76–216 mm</td>
</tr>
<tr>
<td></td>
<td>– 3.0–8.5 inches</td>
</tr>
<tr>
<td></td>
<td>Length:</td>
</tr>
<tr>
<td></td>
<td>– 127–432 mm</td>
</tr>
<tr>
<td></td>
<td>– 5.0–17.0 inches</td>
</tr>
<tr>
<td></td>
<td>• The paper guides rest against the left, right, and bottom edges of the paper.</td>
</tr>
<tr>
<td>Load up to</td>
<td>Make sure</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 25 index cards, photo cards, or postcards | • The thickness does not exceed 0.025 inches (0.635 mm).  
• The print side of the cards faces down.  
• You load the cards vertically and all the way to the back of the paper tray.  
• The paper guides rest against the left, right, and bottom edges of the cards.                                                                                                                                 |
| 20 sheets of banner paper           | • You remove all the paper from the paper tray before loading the banner paper.  
• You tear off only the number of pages needed to print the banner.  
• The print side of the banner faces down into the paper tray with the first page of the banner on top.  
• The leading edge of the banner paper feeds into the printer.  
• The paper guides rest against the right and left edges of the paper.  
• You have selected the correct paper size for the banner in Print Properties. For more information, see “Using Print Properties” on page 38. |
Loading original documents into the ADF

You can load up to 50 sheets of an original document into the ADF for scanning, copying, and faxing. You can load A4, letter, or legal size paper into the ADF.

1 Load an original document text side up into the ADF.

Note: Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

2 Adjust the paper guide on the ADF against the edges of the paper.

ADF paper capacity

<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>50 sheets of</td>
<td>• The document is loaded text side up.</td>
</tr>
<tr>
<td>• Letter paper</td>
<td>• The paper guide is against the edge of the paper.</td>
</tr>
<tr>
<td>• A4 paper</td>
<td></td>
</tr>
<tr>
<td>• Legal size paper</td>
<td></td>
</tr>
<tr>
<td>50 sheets of custom size paper</td>
<td>• The document is loaded text side up.</td>
</tr>
<tr>
<td></td>
<td>• The paper guide is against the edge of the paper.</td>
</tr>
<tr>
<td></td>
<td>• The paper size fits within the allowable dimensions.</td>
</tr>
<tr>
<td>50 sheets of:</td>
<td>• The document is loaded text side up.</td>
</tr>
<tr>
<td>• Pre-punched paper</td>
<td>• The paper guide is against the edge of the paper.</td>
</tr>
<tr>
<td>• Reinforced edge copier paper</td>
<td>• The paper size fits within the allowable dimensions.</td>
</tr>
<tr>
<td>50 sheets of:</td>
<td>• You choose media that absorbs ink well.</td>
</tr>
<tr>
<td>• Preprinted forms</td>
<td>• You allow preprinted media to dry thoroughly before loading into the ADF.</td>
</tr>
<tr>
<td>• Letterhead paper</td>
<td>• You do not use media printed with metallic ink particles.</td>
</tr>
<tr>
<td></td>
<td>• You avoid embossed designs.</td>
</tr>
</tbody>
</table>
Allowable dimensions

- Width:
  - 210.0 mm–215.9 mm
  - 8.27 in.–8.5 in.
- Length:
  - 279.4 mm–355.6 mm
  - 11.0 in.–14.0 in.

Loading original documents on the scanner glass

You can scan and then print photos, text documents, magazine articles, newspapers, and other publications. You can scan a document for faxing. You can also scan three-dimensional objects for use in catalogs, brochures, or product fliers.

Note: Place photos, postcards, small items, thin items (such as magazine clippings), and three-dimensional objects on the scanner glass instead of in the ADF.

1 Make sure the computer and the printer are on.
2 Open the top cover.

3 Place the original document face down on the scanner glass in the upper left corner.

Note: Photos should be loaded as shown.
4 Close the top cover to avoid dark edges on the scanned image.
Printing

Printing a document

1 Load paper.
2 With a document open, click File ➔ Print.
3 Click Properties, Options, Setup, or Preferences.
4 Adjust the settings.
5 Click OK.
6 Click OK or Print.

Printing collated copies

If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

<table>
<thead>
<tr>
<th>Collated</th>
<th>Not collated</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Collated example" /></td>
<td><img src="image2.png" alt="Not collated example" /></td>
</tr>
</tbody>
</table>

1 Load paper.
2 With a document open, click File ➔ Print.
3 Click Properties, Options, Setup, or Preferences.
4 From the Quality/Copies tab, select the number of copies to print.
5 Select the Collate Copies check box.
6 Select the Print Last Page First check box.
7 Click OK.
8 Click OK or Print.

Printing cards

1 Load greeting cards, index cards, or postcards.
2 From the software application, click File ➔ Print.
3 Click Properties, Preferences, Options, or Setup.
4 Select a Quality/Speed setting. Select **Photo** for photos and greeting cards and **Normal** for other types of cards.

5 Select the **Paper Setup** tab.

6 Select **Paper**.

7 From the Paper Size list, select a card size.

8 Click **OK**.

9 Click **OK** or **Print**.

**Notes:**

- To avoid paper jams, do not force the cards into the printer.
- To prevent smudging, remove each card as it exits, and let it dry before stacking.

**Printing envelopes**

1 Load envelopes.

2 From the software application, click **File → Print**.

3 Click **Properties, Preferences, Options, or Setup**.

4 From the “I Want To” menu, select **Print on an envelope**.

5 From the Envelope Size list, select the envelope size loaded.

6 Select **Portrait** or **Landscape** orientation.

   **Notes:**

   - Most envelopes use landscape orientation.
   - Make sure the same orientation is also selected in the software application.

7 Click **OK**.

8 Click **OK**.

9 Click **OK** or **Print**.

**Printing multiple pages on one sheet**

1 Load paper.

2 With a document open, click **File → Print**.

3 Click **Properties, Options, Setup, or Preferences**.
4 From the Print Layout tab, select **N-up**.

5 Select the number of pages to print on each page.

6 If you want each page image to be surrounded by a border, select **Print Page Borders**.

7 Click **OK**.

8 Click **OK** or **Print**.

### Printing the last page first (reverse page order)

1 Load paper.

2 With a document open, click **File ➔ Print**.

3 Click **Properties, Options, Setup**, or **Preferences**.

4 From the Quality/Copies tab, select **Print Last Page First**.

5 Click **OK**.

6 Click **OK** or **Print**.

### Printing transparencies

1 Load transparencies.

2 With a document open, click **File ➔ Print**.

3 Click **Properties, Preferences, Options**, or **Setup**.

4 From the Paper Setup tab, select the size of the transparencies loaded.

5 Click **OK**.

6 Click **OK** or **Print**.
Note: To prevent smudging, remove each transparency as it exits, and let it dry before stacking. Transparencies may require up to 15 minutes to dry.

**Printing a banner**

1. Raise the paper exit tray.
2. Remove all paper from the paper tray.
3. Tear off only the number of pages needed for the banner (up to 20 sheets).
4. Load only the first page of banner paper into the paper tray with the leading edge of the banner going into the printer.

5. Adjust the left and right paper guides.
6. Lower the paper exit tray.
7. With a document open, click **File → Print**.
8. Click **Properties, Options, Setup, or Preferences**.
9. From the Print Layout tab, select **Banner**.
   
   **Note:** After you print a banner, return the setting to **Normal**.

10. To keep banner paper from jamming, select **Letter Banner** or **A4 Banner** from the Banner Paper Size dialog.
11. From the Paper Setup tab, select **Landscape** orientation.
12. Click **OK**.
13. Click **OK** or **Print**.
Getting ready to print photos using memory devices

Inserting a memory card

1. Insert a memory card into the correct memory card slot on the front of the printer. If there is an arrow on the card, make sure it points toward the printer.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Memory card</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>• xD Picture Card</td>
</tr>
<tr>
<td></td>
<td>• SmartMedia</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Make sure the gold contact area faces up, and insert the card all the way in quickly.</td>
</tr>
<tr>
<td>2</td>
<td>• Memory Stick</td>
</tr>
<tr>
<td></td>
<td>• Memory Stick PRO</td>
</tr>
<tr>
<td></td>
<td>• Memory Stick Duo (with adapter) or Memory Stick PRO Duo (with adapter)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Make sure to connect the memory card to the adapter that came with it before inserting it in the slot.</td>
</tr>
<tr>
<td>3</td>
<td>• Secure Digital</td>
</tr>
<tr>
<td></td>
<td>• Mini Secure Digital (with adapter)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Make sure to connect the memory card to the adapter that came with it before inserting it in the slot.</td>
</tr>
<tr>
<td></td>
<td>• MultiMedia</td>
</tr>
<tr>
<td>4</td>
<td>• CompactFlash Type I and Type II</td>
</tr>
<tr>
<td></td>
<td>• Microdrive</td>
</tr>
</tbody>
</table>
2 Wait for the light on the printer to come on. The light blinks to indicate the memory card is being read or is transmitting data.

**Warning:** Do *not* remove cables, media devices, or touch the printer while the light is blinking in the area shown.

If the printer does not read the memory card, remove and reinsert it.

**Note:** The printer reads only one media device at a time.

**Inserting a flash drive**

1 Insert the flash drive into the PictBridge port on the front of the printer.

**Notes:**
- An adapter may be necessary if your drive does not fit directly into the port.
- The printer reads only one media device at a time.
2 Wait for the light on the printer to come on. The light blinks to indicate the flash drive is being read or is transmitting data.

Warning: Do not remove cables or media devices, or touch the printer while the light is blinking in the area shown.

Browsing and selecting photos from a memory card or flash drive

1 Load paper. For best results, use photo or glossy paper, with the glossy or coated side facing down.

2 Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

3 Press ✓.

4 Press ▲ or ▼ repeatedly until the photo size and paper option you want is highlighted.

5 Press ✓.

6 Press ◀ or ▶ repeatedly to browse through the photos.

7 Press ✓ to select the currently displayed photo.

Press ❌ to deselect the currently displayed photo.
Transferring digital photos from a memory card or flash drive

**Transferring photos using the control panel**

1. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

2. Press ▲ or ▼ repeatedly until **Save to Computer** is highlighted.

3. Press ✓.

4. Press **Start Color** or **Start Black**.

5. Follow the instructions on the computer screen to specify where you want to save the images.

**Transferring photos using the computer**

1. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

2. From the Fast Pics dialog, click **Save Photos to PC**.

3. Select the photos you want to save, and then click **Next**.

4. Specify where you want to save the images.

5. Specify whether or not you want to erase all photos from the memory card or flash drive after saving the photos to the computer.
   
   **Note:** Select **No** unless you want to delete the photos from the memory card permanently.

6. Click **Save Now**.
Using a PictBridge-enabled digital camera to control printing photos

Connect a PictBridge-enabled digital camera to the printer, and use the buttons on the camera to select and print photos.

1 Insert one end of the USB cable into the camera.
   Note: Use only the USB cable that came with the digital camera.

2 Insert the other end of the cable into the PictBridge port on the front of the printer.

Notes:
- Make sure the PictBridge-enabled digital camera is set to the correct USB mode. For more information, see the camera documentation.
- The printer reads only one media device at a time.

3 Follow the instructions in the camera documentation to select and print photos.
   Warning: Do not remove cables or media devices, or touch the printer while the light is blinking in the area shown.
Printing photos using the control panel

Printing photos using the control panel

1 Load paper. For best results, use photo or glossy paper, with the glossy or coated side facing down.

2 Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

3 From the control panel, press ✓ to select Browse and Print Photos.

4 Press ▲ or ▼ repeatedly until the photo size and paper option you want is highlighted.

5 Press ✓.

6 Press ◀ or ▶ repeatedly to browse through the photos.

7 Press ✓ to select the currently displayed photo.

   Note: To deselect the currently displayed photo, press ✓ or X.

8 To make multiple prints, press ▲ or ▼ repeatedly until the number of prints you want appears.

9 To edit the currently displayed photo, press 📊, and then press ✓.

10 Press ▲ or ▼ repeatedly until the option you want is highlighted.

   Options include:
   • Brightness
   • Crop
   • Auto Image Enhance
   • Red Eye
   • Colorized Effect
   • Rotate

11 Press ✓ to select an option or save a setting.

12 Press ◀ twice to return to the photo selection screen.

13 Press Start Color or Start Black.

   A preview of the print job appears.

14 Press Start Color or Start Black.
**Printing a DPOF selection**

Digital Print Order Format (DPOF) is a feature available on some digital cameras. If your camera supports DPOF, you can specify which photos to print, and how many of each, while the memory card is still in the camera. The printer recognizes these settings when you insert the memory card into the printer.

**Note:** If you specified a paper size in the DPOF selection, make sure the size of the paper loaded is not smaller than the size you specified.

1. Load paper. For best results, use photo or glossy paper, with the glossy or coated side facing down.
2. Insert a memory card. For more information, see “Inserting a memory card” on page 54.
3. Press ▲ or ▼ repeatedly until Print Camera Selections is highlighted.
4. Press √. A preview of the print job appears.
5. Press Start Color or Start Black to print the photos.

**Viewing a photo slide show on the control panel**

You can view a slide show of the photos saved on a memory card or flash drive.

1. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.
2. Press ▲ or ▼ repeatedly until View Slide Show is highlighted.
3. Press √.

   **Note:** Press X when you are finished viewing the slide show.

**Changing the default photo print settings**

1. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.
2. Press ▲ or ▼ repeatedly until Change Default Settings is highlighted.
3. Press √.
   A menu appears with an asterisk (*) in front of the current default settings.
4. Press ▲ or ▼ repeatedly until the menu option you want to change is highlighted.
5. Press ◀ or ▶ repeatedly until the setting you want appears.
6. Press √.
7. To change additional settings, repeat step 4 through step 6.
**Adjusting brightness**

1. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

2. From the control panel, press \( \checkmark \) to select **Browse and Print Photos**.

3. Press \( \uparrow \) or \( \downarrow \) repeatedly until the photo size and paper option you want is highlighted.

4. Press \( \checkmark \).

5. Press \( \checkmark \).

6. Press \( \leftarrow \) or \( \rightarrow \) repeatedly until the photo you want to adjust appears.

7. Press \( \checkmark \).

8. Press \( \equiv \).

9. Press \( \checkmark \) to select **Edit Photo**.

10. Press \( \checkmark \) to select **Brightness**.

11. Press \( \leftarrow \) or \( \rightarrow \) repeatedly to make the photo lighter or darker.

12. Press \( \checkmark \) to save the setting.

**Cropping photos using the control panel**

1. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.

2. From the control panel, press \( \checkmark \) to select **Browse and Print Photos**.

3. Press \( \uparrow \) or \( \downarrow \) repeatedly until the photo size and paper option you want is highlighted.

4. Press \( \checkmark \).

5. Press \( \checkmark \).

6. Press \( \leftarrow \) or \( \rightarrow \) repeatedly until the photo you want to crop appears.

7. Press \( \checkmark \).

8. Press \( \equiv \).

9. Press \( \checkmark \) to select **Edit Photo**.

10. Press \( \uparrow \) or \( \downarrow \) repeatedly until **Crop** is highlighted.

11. Press \( \checkmark \).
12 Adjust the crop area.
   • Press # to reduce the selected area.
   • Press * to increase the selected area.
   • Press 0 to change the orientation of the selection box.
   • Use the arrow buttons to move the selection box up, down, left, or right.

13 Press  or  to save the settings and exit the menu.
Printing photos using the computer

Printing photos using the computer

Printing photos stored on the computer

1. Load paper. For best results, use photo or glossy paper with the glossy or coated side facing down.

2. From the desktop, double-click the Productivity Suite icon.

3. Click Manage Photos.
   The All-In-One Center appears with the Saved Images tab expanded.

4. Click Show Folders.

5. From the directory in the right panel, select the folder where your photos are stored.

6. Close the directory in the right panel.

7. Select the photos that you want to print by clicking each photo.

8. Click Next in the Photo Prints section.
   The Fast Pics window appears.

9. Select the size for each photo, the blank paper size in the printer, and the number of copies.

10. Click Print Now.

Printing photos stored on a memory device

1. Load paper. For best results, use photo or glossy paper with the glossy or coated side facing down.

2. Insert a memory card or flash drive. For more information, see “Inserting a memory card” on page 54 or “Inserting a flash drive” on page 55.
   The Fast Pics dialog appears.

3. Click View and Print Photos.

4. From the dialog that appears, click the white box on each photo that you want to print.

5. Select the size for each photo, the blank paper size in the printer, and the number of copies.

6. Click Print Now.

Printing borderless photos

1. Load photo paper. For best results, use photo or glossy paper with the glossy or coated side facing down.

2. From the desktop, double-click the Productivity Suite icon.
3 Click **Manage photos**.
4 Click **Show Folders**.
5 From the directory in the right panel, select the folder where your photos are stored.
6 Close the directory in the right panel.
7 Select the photos that you want to print by clicking each photo.
8 From the Productivity Tools section, click **Print an album page with various photo sizes**.
9 Click **Change the category of layouts listed above**.
10 Select **Only Borderless**.
11 Click **OK**.
12 Select a paper size for the photos.
13 Select a page layout.
14 Drag your photos onto the page.
15 Click **Print Now**.

**Browsing and selecting photos stored on the computer**
1 From the desktop, double-click **Productivity Suite**.
2 Click **Manage Photos**.
3 Click **Show Folders**.
4 Select the folder where the photos are stored.
5 Close the folder directory.
6 Select the photos you want to print by clicking each photo.

**Creating and printing a scrapbook or album page**
1 Load paper. For best results, use photo or glossy paper with the glossy or coated side facing down.
2 From the desktop, double-click the **Productivity Suite** icon.
3 Click **Manage Photos**.
4 Click **Show Folders**.
5 From the directory in the right panel, select the folder where your photos are stored.
6 Close the directory in the right panel.
7 From the Productivity Tools section, click **Print an album page with various photo sizes**.
8 From the “Paper Size” drop-down menu, select a paper size.
9 From the “Page Layout” drop-down menu, select a page layout.
   
   For more options:
   
   a Click Change the category of layouts listed above.
   
   b Select a layout for the photos.
   
   c Click OK.
   
   d From the “Page Layout” drop-down menu, select a page layout.

10 Drag the photos onto the page.
   
   Note: Right-click the photo on the page for editing options.

11 Click Print Now.
   
   Note: To prevent smudging, remove each page as it exits, and let it dry before stacking.

Adding text captions to a photo page

1 Load paper. For best results, use photo or glossy paper with the glossy or coated side facing down.

2 From the desktop, double-click the Productivity Suite icon.

3 Click Manage Photos.

4 Click Show Folders.

5 From the directory in the right panel, select the folder where your photos are stored.

6 Close the directory in the right panel.

7 Browse and select the photos to which you want to add text.

8 From the Productivity Tools section, click Print an album page with various photo sizes.

9 Click Change the category of layouts listed above.

10 Select Only Scrapbook Pages.

11 Click OK.

12 Select a paper size for the photos.

13 Select a page layout containing a black box.

14 Drag the photos onto the page.

15 Click inside the white box.
   
   A dialog appears.

16 Enter the text you want.

17 Click OK.

18 Click Print Now to print the photo page.
Copying

You can load an original document into the ADF or on the scanner glass.

<table>
<thead>
<tr>
<th>ADF</th>
<th>Scanner glass</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ADF Image]</td>
<td>![Scanner Glass Image]</td>
</tr>
</tbody>
</table>

**Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

**Making a copy**

**Making a copy using the control panel**

1. Load paper.
2. Load an original document into the ADF or on the scanner glass.
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
3. From the control panel, press **Copy Mode**.
4. Press **Start Color** or **Start Black**.

**Making a copy using the software**

1. Load paper.
2. Load an original document into the ADF or on the scanner glass.
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
3. From the desktop, double-click the **Productivity Suite** icon.
4. Click **Copy**.
5. Customize the settings as needed.
6 Click Display Advanced Copy Settings.
7 Customize any other settings as needed.
8 Click OK.
9 Click Copy Now.

Repeating an image on one page using the control panel
You can print the same image multiple times on one sheet of paper. This option is helpful in creating labels, decals, flyers, handouts, and so on.

1 Load paper.
   Note: If you are copying photos, use photo or glossy paper, with the glossy or coated side facing down.
2 Load an original document face down on the scanner glass.
3 From the control panel, press Copy Mode.
4 Press ▲ or ▼ repeatedly until Repeat (per page) is highlighted.
5 Press ◀ or ▶ repeatedly until the number of images you want to print on one page appears.
6 Press ▲ or ▼ repeatedly until Paper Size is highlighted.
7 Press ◀ or ▶ repeatedly until the paper size you want appears.
8 Press Start Color or Start Black.

Collating copies

Collating copies using the control panel
If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

Collated

Not collated

1 Load an original document into the ADF.
2 From the control panel, press Copy Mode.
3 Press ◀ or ▶ repeatedly until the number of copies you want to print appears.
4 Press ▲ or ▼ repeatedly until Collate is highlighted.
5 Press ◀ or ▶ repeatedly until On appears.

6 Press Start Color or Start Black.

**Collating copies using the software**

1 Load paper.

2 Load an original document into the ADF or on the scanner glass.
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the desktop, double-click the **Productivity Suite** icon.

4 Click **Copy**.

5 Customize the settings as needed.

6 Click **Display Advanced Copy Settings**.

7 Make sure **Collate Copies** is selected.

8 Make sure **Print Last Page First** is selected.

9 Customize any other settings as needed.

10 Click **OK**.

11 Click **Copy Now**.

**Making borderless copies**
Making borderless copies using the control panel

1. Load paper.
   - **Note:** If you are copying photos, use photo or glossy paper, with the glossy or coated side facing down.

2. Load an original document into the ADF or on the scanner glass.
   - **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3. From the control panel, press **Copy Mode**.

4. Press ▲ or ▼ repeatedly until **Quality** is highlighted.

5. Press ◀ or ▶ repeatedly until **Photo** appears.

6. Press ▲ or ▼ repeatedly until **Paper Size** is highlighted.

7. Press ◀ or ▶ repeatedly until the paper size you want appears.

8. Press **Start Color** or **Start Black**.

Making borderless copies using the software

1. Load paper.
   - **Note:** If you are copying photos, use photo or glossy paper, with the glossy or coated side facing down.

2. Load an original document into the ADF or on the scanner glass.
   - **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3. From the desktop, double-click the **Productivity Suite** icon.

4. Click **Copy**.

5. Select a copy quantity, and then select **Color Photo** from the drop-down menu.

6. Click **Best**.

7. Select a blank paper size.

8. Click **Copy Now**.
Enlarging or reducing an image

**Enlarging or reducing an image using the control panel**

1. Load paper.

2. Load an original document into the ADF or on the scanner glass.
   
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3. From the control panel, press **Copy Mode**.

4. Press ▲ or ▼ repeatedly until **Enlarge** is highlighted.

5. Press ◀ or ▶ repeatedly until the option you want appears.

6. Press ▲ or ▼ repeatedly until **Paper Size** is highlighted.

7. Press ◀ or ▶ repeatedly until the paper size you want appears.

8. Press **Start Color** or **Start Black**.

**Enlarging or reducing an image using the software**

1. Load paper.

2. Load an original document into the ADF or on the scanner glass.
   
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3. From the desktop, double-click the **Productivity Suite** icon.

4. Click **Copy**.

5. Click **Show Productivity Tools**.

6. Click **Enlarge or reduce an image**.

7. Follow the instructions on the computer screen.
Scanning

You can load an original document into the ADF or on the scanner glass.

<table>
<thead>
<tr>
<th>ADF</th>
<th>Scanner glass</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ADF Image]</td>
<td>![Scanner Glass Image]</td>
</tr>
</tbody>
</table>

**Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

### Scanning multiple pages

**Scanning multiple pages using the ADF**

1. Load an original document into the ADF.
   
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

2. From the control panel, press **Scan Mode**.

3. Press ▲ or ▼ repeatedly until the destination to which you want to scan appears.

4. Press ✓.

5. Press **Start Color** or **Start Black**.

**Scanning multiple pages using the scanner glass**

1. Load an original document face down on the scanner glass.

2. From the desktop, double-click the **Productivity Suite** icon.

3. Click **Scan**.

4. From the “Send scanned image to” menu, select a scan destination.

5. Click **Display Advanced Scan Settings**.
6 Select Scan multiple items before output.
7 Click OK.
8 Click Scan Now.
9 When prompted, place the next page on the scanner glass, and then click Yes.
10 Continue step 9 until all pages are scanned.
11 When you are finished with your scan, click No on the dialog that appears.

Scanning to an application

Scanning to an application using the control panel

1 Make sure the printer is connected to a computer, and both the printer and computer are on.
2 Load an original document into the ADF or on the scanner glass.
   Note: Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
3 Press Scan Mode.
4 Press ▲ or ▼ repeatedly until the application to which you want to scan is highlighted.
5 Press √.
6 Press Start Color or Start Black.

Scanning to an application using the computer

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.
2 Load an original document into the ADF or on the scanner glass.
   Note: Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
3 From the desktop, double-click the Productivity Suite icon.
4 Click Scan.
5 Click Preview Now to view the scanned image.
   Note: If the size of the scanned image (found in the lower right of the preview window) appears in red, you do not have the system resources available to perform the scan at the resolution or size you have selected. Reduce the resolution or the size of the scan area.
6 Adjust the dotted lines to fit around the part of the image you want to scan.
7 From the “Send scanned image to” drop-down menu, select a scan destination.
8 To further customize the scan job, click Display Advanced Scan Settings.

9 When you are finished customizing the image, click Scan Now.

Scanning a one-page document using the control panel

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.
2 Load an original document face down on the scanner glass.

3 Press Scan Mode.

4 Press ‹ or › repeatedly until the application to which you want to scan appears.

5 Press √.

6 Press Start Color or Start Black.

Scanning documents or images for e-mailing

Scanning documents or images for e-mailing using the control panel

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.
2 Load an original document into the ADF or on the scanner glass.
   
   Note: Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the control panel, press Scan Mode.

4 Press ‹ or › repeatedly until E-mail is highlighted.

5 Press √.
   A preview of the scan appears.

6 Press Start Color or Start Black.

7 Follow the instructions on the computer screen.
Scanning documents or images for e-mailing using the computer

1. Make sure the printer is connected to a computer, and both the printer and the computer are on.
2. Load an original document into the ADF or on the scanner glass.
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
3. From the desktop, double-click the Productivity Suite icon.
4. Click Attach to E-mail.
5. Click Scan and e-mail a document or photo.
6. Click Preview Now.
7. From the “What is being scanned?” menu, select a document type.
8. Click Next.
9. Follow the instructions on the screen to prepare the document or image for e-mailing.
10. Click Attach.
11. Write a note to accompany the attached document or image, and then send it.

Scanning documents to edit text

Use the Optical Character Recognition (OCR) software feature to turn scanned images into text you can edit with a word-processing application.

**Note:** Make sure that ABBYY Fine Reader is installed.

1. Load an original document into the ADF or on the scanner glass.
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
2. Double-click the Productivity Suite icon.
3. Click Scan & Edit Text (OCR).
4. Click Preview Now.
5. Select a word-processing program to edit the text.
6. Click Send Now.
7. Edit and save the document.
Scanning clear images from magazines or newspapers

Descreening helps to remove wavy patterns from images scanned from magazines or newspapers.

1 Make sure the printer is connected to a computer, and both the printer and the computer are on.

2 Load an original document into the ADF or on the scanner glass.
   
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the desktop, double-click the **Productivity Suite** icon.

4 Click **Scan**.

5 Click **Display Advanced Scan Settings**.

6 Select the **Image Patterns** tab.

7 Select the **Remove image patterns from magazine/newspaper (descreen)** check box.

8 From the “What is being scanned?” menu, select **Magazine** or **Newspaper**.

9 Click **OK**.

10 Click **Scan Now**.

Editing scanned images using a graphics program

1 From the desktop, double-click the **Productivity Suite** icon.

2 Click **Scan**.

3 From the “Send scanned image to” menu, select a graphics program to edit the images.

4 Click **Scan Now**.

   When the image finishes processing, it opens in the program you selected.

5 Edit the image using the tools available in the graphics program. For more information, see the documentation that came with the graphics program.

Scanning to a computer over a network

1 Make sure:
   
   • The printer is connected to the network through a print server, and the printer, print server, and computer receiving the scan are on.
   
   • The printer is configured to scan over a network (Direct IP Printing).

2 Load an original document into the ADF or on the scanner glass.
   
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3 From the control panel, press **Scan Mode**.
4 Press ▲ or ▼ repeatedly until the computer to which you want to scan is highlighted.

5 If you set a PIN during network setup, you will be prompted to enter it. After you enter it, press ✔.
   **Note:** If you did not set a PIN during network setup, continue with the next step.

6 Press ▲ or ▼ repeatedly until the scan destination you want is highlighted.

7 Press ✔.
   **Note:** If you want to change the scan settings, press  

8 Press **Start Color** or **Start Black**.
Faxing

You can load an original document into the ADF or on the scanner glass.

<table>
<thead>
<tr>
<th>ADF</th>
<th>Scanner glass</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ADF Image]</td>
<td>![Scanner Glass Image]</td>
</tr>
</tbody>
</table>

**Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

**Sending a fax**

**Faxing a document using the control panel**

1. Make sure the printer is on.
2. Load an original document into the ADF or on the scanner glass.
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
3. From the control panel, press **Fax Mode**.
4. Enter a fax number; press **Quick Dial 1, 2, 3, 4, or 5**; or press **Phone Book** to select a number from the Speed Dial list.
   **Note:** If you do not have a Speed Dial list but want to create one, see “Setting up Speed Dial” on page 80.
5. Press **Start Black**.
   The printer scans the document and sends the fax to the number you entered.
**Faxing a document using the software**

You can scan a document to the computer and then fax it to someone using the software.

1. Make sure the printer is connected to a computer, and both the printer and the computer are on.

2. Load an original document into the ADF or on the scanner glass.
   - **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

3. From the desktop, double-click the **Productivity Suite** icon.

4. Click **Fax**.

5. Click **Fax a document in the All-in-One**.

6. Follow the instructions on the computer screen to complete the task.

**Faxing a document using an application**

You can create a soft-copy document on the computer, and then send a black-and-white fax of it to someone else.

**Note:** You cannot receive soft-copy faxes, only send them. All incoming faxes will print from the printer.

To send a fax from a computer program using the fax modem in the printer:

1. With a document open, click **File → Print**.

2. From the Printer list, select the fax driver for your printer.

3. Click **OK**.

4. To send a soft-copy fax, follow the instructions in the program that launches.

**Note:** All faxes sent using the soft-copy fax feature appear in Fine resolution.

**Receiving a fax**

**Receiving a fax automatically**

1. Press **Fax Auto Answer**.

2. If you would like to set a specific number of rings after which the printer will automatically receive faxes, see “Setting the number of rings before receiving a fax automatically” on page 79.
Receiving a fax with an answering machine

To receive a fax with an answering machine connected to the printer, set the answering machine to answer incoming calls before the printer does. For example, if you set the answering machine to answer calls after three rings, set the printer to answer calls after five rings.

1. From the control panel, press Fax Mode.
2. Press \[ \]
3. Press ▲ or ▼ repeatedly until Ringing and Answering is highlighted.
4. Press \( ✔ \).
5. Press ▲ or ▼ repeatedly until Pick-Up On: is highlighted.
6. Press ◀ or ▶ to choose an option.
7. Press \( ✔ \).
8. Make sure the Fax Auto Answer light is on.

When a ring is detected, the answering machine picks up the call.
- If the printer detects a fax, it receives the fax and disconnects the answering machine.
- If the printer does not detect a fax, the answering machine receives the call.

Note: You must set up the equipment as shown in “Connecting to an answering machine” on page 17.

Receiving a fax manually

1. Make sure the Fax Auto Answer light is off.
2. To receive the fax, press:
   - Start Black
   - 9 on the keypad
   - * 9 * on the telephone after you answer it and hear fax tones.
   Hang up the telephone.

Setting the number of rings before receiving a fax automatically

1. From the control panel, press Fax Mode.
2. Press \[ \]
3. Press ▲ or ▼ repeatedly until Ringing and Answering is highlighted.
4. Press \( ✔ \).
5 Press ▲ or ▼ repeatedly until **Pick-Up On:** is highlighted.

6 Press ◀ or ▶ to choose an option.

7 Press ✓.

8 If you want to set a schedule to turn Auto Answer on or off:
   a Press ▲ or ▼ repeatedly until **Auto Answer Scheduling** is highlighted.
   b Press ◀ or ▶ until On appears.
   c Press ✓.
   d Press ▼ to select the time for Auto Answer On.
   e Use the keypad to enter the date and time. Press 1 for AM, 2 for PM, or 3 for 24-hour mode.
   f Press ▼ to select the time for Auto Answer Off.
   g Repeat step e.
   h Press ◀ to save the settings and exit the menu.

9 Make sure the Fax Auto Answer light is on.

When the number of rings you set is detected, the printer automatically receives the incoming fax.

**Setting up Speed Dial**

To make sending faxes easier, you can enter up to 99 Speed Dial numbers. You can enter 89 individual fax numbers and 10 groups that can hold up to 30 telephone numbers each.

*Setting up Speed Dial using the control panel*

1 From the control panel, press **Fax Mode**.

2 Press ▲ or ▼ repeatedly until **Add from Phone Book** is highlighted.

3 Press ✓.

4 Press ▲ or ▼ repeatedly until **New/Edit Individual** is highlighted.

5 Press ✓.

6 Press ▲ or ▼ repeatedly until a blank entry is highlighted, and then press ✓.

7 Enter the name using the keypad, and then press ✓.

   To enter a name using the keypad:
   a Find the number button that corresponds to the letter you want, and then press it repeatedly until the correct letter appears.
   b Press 0 to enter a space between words.
   c Press ◀ to delete a letter.
   d Repeat the previous steps until you have entered the name.
Note: The printer does not support double-byte usage for names, such as Chinese, Japanese, or Korean. You cannot enter a name using these languages.

8 Enter the fax number, and then press √.

**Setting up Speed Dial using the computer**

1 From the desktop, double-click the **Productivity Suite** icon.
2 Click **Fax**.
3 Click **Manage fax history or All-In-One fax settings**.
4 Click the **Speed Dial** tab.
5 Add a new number to your Speed Dial list.
   a Click one of the lines in the list.
   b Enter a fax number.
   c Place the cursor in the Contact Name field.
   d Enter a contact name.

   Note: The printer does not support double-byte usage for names, such as Chinese, Japanese, or Korean. You cannot enter a name using these languages.
6 Click **OK**.

**Using Speed Dial**

1 Load an original document into the ADF or on the scanner glass.

   Note: Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
2 From the control panel, press **Fax Mode**.
3 Press **Phone Book**.
4 Press ▲ or ▼ repeatedly until the Speed Dial entry you want is highlighted.
5 Press √.
6 Press **Start Black** to send your fax.
Sending a fax to a group (broadcast fax)

You can send a fax to as many as 30 people or groups at once.

**Sending a broadcast fax immediately**

1. Load an original document into the ADF or on the scanner glass.
   
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

2. From the control panel, press **Fax Mode**.

3. Enter a fax number.
   - Enter a fax number in the text box.
     
     **Note:** To enter another number in the text box, press ▼ until **Enter Another Number** is highlighted, and then press ✓. Enter the second number in the text box.
   - Use Quick Dial.
     a. Press **Quick Dial 1, 2, 3, 4 or 5**.
     b. Press ✓.
     c. Press ▶.
   - Enter a Speed Dial or Group Dial number.
     a. Press **Phone Book**.
     b. Press ▲ or ▼ repeatedly until the Speed Dial or Group Dial number you want is highlighted, and then press ✓. To select more numbers, repeat this step.
     c. Press ▶.

4. Continue step 3 until all of the fax numbers (up to 30 numbers) have been entered.

5. Press **Start Black** to send the fax to the numbers you entered.

**Sending a broadcast fax at a scheduled time**

1. Load an original document into the ADF or on the scanner glass.
   
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

2. From the control panel, press **Fax Mode**.
3 Enter a fax number.
   • Enter a fax number in the text box.
     
     **Note:** To enter another number in the text box, press ▼ until **Enter Another Number** is highlighted, and then press ✓. Enter the second number in the text box.

• Use Quick Dial.
  a  Press **Quick Dial 1, 2, 3, 4 or 5**.
  b  Press ✓.
  c  Press ➔.

• Enter a Speed Dial or Group Dial number.
  a  Press **Phone Book**.
  b  Press ▲ or ▼ repeatedly until the Speed Dial or Group Dial number you want is highlighted, and then press ✓. To select more numbers, repeat this step.
  c  Press ➔.

4 Continue step 3 until all of the fax numbers (up to 30 numbers) have been entered.

5 Press □.

6 Press ✓ to select **Delay Sending Fax**.

7 Press ✓ to select **Delay Current Fax**.

8 Enter the time and date you want to send the fax.
   • Use the arrows to navigate to each box.
   • Press 1 for AM, 2 for PM, or 3 for 24-hour mode.

9 Press **Start Black** to send your fax.

**Note:** At the designated time, the fax numbers are dialed and the fax is sent to all of the designated fax numbers. If the fax transmission is unsuccessful to any of the numbers on the broadcast list, the unsuccessful numbers will be tried again.

**Using the Quick Dial buttons**

You can access Speed Dial numbers 1–5 with the Quick Dial buttons. These buttons are automatically programmed when you program the first five Speed Dial numbers. The first five numbers assigned become Quick Dial 1, 2, 3, 4, and 5.

1 Load an original document into the ADF or on the scanner glass.
   **Note:** Do not load postcards, photo cards, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

2 From the control panel, press **Fax Mode**.

3 Press **Quick Dial 1, 2, 3, 4, or 5**.
4 Press ✓.

5 Press Start Black.

Using the Phone Book

The Phone Book is a directory of Speed Dial entries. For instructions on how to add Speed Dial entries to the Phone Book, see “Setting up Speed Dial” on page 80.

To access the Phone Book menu:

1 From the control panel, press Fax Mode.

2 Press Phone Book.

<table>
<thead>
<tr>
<th>Use this</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by Name</td>
<td>Sort the Speed Dial entries alphabetically.</td>
</tr>
<tr>
<td>Sort by Speed Dial Number</td>
<td>Sort the Speed Dial entries numerically.</td>
</tr>
<tr>
<td>Print Phone Book</td>
<td>Print all Speed Dial numbers (1–99) listed in the Phone Book.</td>
</tr>
<tr>
<td>New/Edit Individual</td>
<td>Edit an individual Speed Dial entry, or create a new Speed Dial entry.</td>
</tr>
<tr>
<td>New/Edit Group</td>
<td>Edit a group Speed Dial entry, or create a new Speed Dial entry.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a Speed Dial entry.</td>
</tr>
</tbody>
</table>

Faxing while listening to a call (On Hook Dial)

The manual dialing feature lets you dial a telephone number while listening to the call through a speaker on the printer. It is useful when you must navigate an automated answering system before sending your fax.

1 From the control panel, press Fax Mode.

2 Press InMillis.

3 Press ▲ or ▼ repeatedly until On Hook dial is highlighted.

4 Press ✓ twice.

You can now hear the dial tone of the telephone line.

5 Enter the number to which you want to send a fax.

Note: Press the keypad numbers to use an automated answering system.

6 Press Start Black.
Dialing a fax number while behind a PBX

If the printer is being used in a business or office, it may be connected to a Private Branch Exchange (PBX) telephone system. Ordinarily, when dialing a fax number, the printer waits to recognize the dial tone and then dials the fax number. However, this method of dialing may not work if the PBX telephone system uses a dial tone that is not recognizable to most fax machines. The “Dialing while behind a PBX” feature enables the printer to dial the fax number without waiting to recognize the dial tone.

1. From the control panel, press **Fax Mode**.
2. Press 📡.
3. Press ▲ or ▼ repeatedly until **Dialing and Sending** is highlighted.
4. Press ✔.
5. Press ▲ or ▼ repeatedly until **Dial Method** is highlighted.
6. Press ◀ or ▶ repeatedly until **Dial PBX (Dial Tone Detect Off)** appears.
7. Press 🔄 to save this setting and exit the menu.

Setting the distinctive ring using the control panel

1. From the control panel, press **Fax Mode**.
2. Press 📡.
3. Press ▲ or ▼ repeatedly until **Ringing and Answering** is highlighted.
4. Press ✔.
5. Press ▲ or ▼ repeatedly until **Distinct Ring** is highlighted.
6. Press ◀ or ▶ repeatedly until the ring pattern you want appears.
7. Press ✔.

Forwarding faxes

Use the fax forwarding feature if you are going to be away, but still want to receive your faxes. There are three fax forwarding settings:

- **Off**—(Default).
- **Forward**—The printer sends the fax to the designated fax number.
- **Print & Forward**—The printer prints the fax and then sends it to the designated fax number.

Setting up fax forwarding

1. From the control panel, press **Fax Mode**.
2. Press 📡.
3 Press ▲ or ▼ repeatedly until **Ringing and Answering** is highlighted.

4 Press ✔.

5 Press ◀ or ▶ repeatedly until **Forward** appears.

6 Press ✔.

7 Enter the number to which you want to forward the fax.

8 Press ✔.

9 Press ◄ to save the setting and exit the menu.

**Using Caller ID**

Caller ID is a service provided by some telephone companies that identifies the telephone number (and possibly the name) of the person who is calling. If you subscribe to this service, it works with the printer. When you receive a fax, the telephone number of the person who is sending you the fax appears on the display.

**Note:** Caller ID is available only in some countries and regions.

**Blocking junk faxes**

1 From the control panel, press **Fax Mode**.

2 Press ◆.

3 Press ▲ or ▼ repeatedly until **Junk Fax Blocking** is highlighted.

4 Press ✔.

5 Press ◀ or ▶ repeatedly until **On** appears.

6 Press ▲ or ▼ repeatedly until **Add Number to Block** is highlighted.

7 Press ✔.

8 Use the keypad buttons to enter a name, and then press ▼ to enter the corresponding fax number.

9 Press ✔ to save this entry.

10 Press ▲ or ▼ repeatedly until **View Block List** is highlighted, and then press ✔ to check or edit your entry.
Customizing settings using the Fax Setup Utility

You can adjust the fax settings in the Fax Setup Utility. These settings apply to the faxes you send or receive.

1. From the desktop, double-click the Productivity Suite icon.
2. Click Fax.
3. Click Manage fax history or All-In-One fax settings..
4 Click each tab, and change the settings as needed.

<table>
<thead>
<tr>
<th>On this tab</th>
<th>You can</th>
</tr>
</thead>
</table>
| **Send**    | • Choose whether to use error correction.  
• Enter your name and fax number.  
• Select a maximum send speed and print quality for outgoing faxes.  
• Choose whether to scan the entire document before dialing the number.  
• Select when to print a fax usage report.  
• Select when to print a fax activity report. |
| **Receive**  | • Choose whether to print a footer (the date, time, and page number) to appear on each page you receive.  
• Automatically reduce an incoming fax to fit to the paper size loaded, or print it on two sheets of paper.  
• Select whether you want to forward a fax, or print it and then forward it.  
• Select incoming call options.  
• Manage blocked faxes. |
| **Connection/Dialing** | • Select the number of times you want the machine to redial and the time between those attempts if the fax cannot be sent on the first try.  
• Select the telephone line format you want to use.  
• Enter a dialing prefix.  
• Choose how you want to answer incoming calls (manually; if fax tones are detected; or after a certain amount of rings). |
| **Speed Dial** | Add to, create, edit, or delete entries from the Speed Dial list, including group Speed Dial entries. |

5 Click **OK** after you finish customizing the settings.

6 Close the Fax Setup Utility.

**Printing fax activity reports**

1 From the control panel, press **Fax Mode**.

2 Press `Fax`.  

3 Press ▲ or ▼ repeatedly until History and Reports is highlighted.

4 Press √.
5 Press ▲ or ▼ repeatedly until Print Sent History or Print Received History is highlighted.

6 Press √.

**Blocking unwanted changes to fax settings**

This feature blocks network users from changing fax settings.

1 From the control panel, press Fax Mode.

2 Press □.

3 Press ▲ or ▼ repeatedly until Block Host Settings is highlighted.

4 Press ◀ or ▶ until on appears.

5 Press √ to save this setting.
Networking the printer

Installing network printers

Installing a network printer allows users at different workstations to print to a common printer. Methods of setting up a network printer include:

- sharing a printer that is locally attached to a network computer
- a direct Ethernet connection through a print server

Shared printing

Installing software and sharing the printer on the network (on the host computer)

1. Connect the printer to a network computer using a USB cable.
   - If the Found New Hardware dialog appears, click Cancel.

2. Insert the printer software CD.

3. Click Install.

4. Click Continue.

5. Select Yes to share your printer.

6. Assign a shared printer name.

7. When prompted, select Test Page to make sure that the computer can print to the printer.

8. Follow the directions on the computer screen until installation is complete.
### Installing the shared printer on other network computers (on the client computers)

#### Using the peer-to-peer method

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Go to a network computer that you want to enable to print to the shared printer.</td>
</tr>
<tr>
<td>b</td>
<td>Insert the printer CD.</td>
</tr>
<tr>
<td>c</td>
<td>Click <strong>Install</strong>.</td>
</tr>
<tr>
<td>d</td>
<td>From the “Connect Your Printer” dialog, select the network option.</td>
</tr>
<tr>
<td>e</td>
<td>From the “Networking Setup” dialog, select <strong>Peer-to-Peer</strong>.</td>
</tr>
<tr>
<td>f</td>
<td>Enter the shared names of both the printer and the network computer you assigned in step 6 on page 90.</td>
</tr>
<tr>
<td>g</td>
<td>When prompted, select <strong>Test Page</strong> to make sure the computer can print to the shared printer.</td>
</tr>
<tr>
<td>h</td>
<td>Follow the instructions on the computer screen until installation is complete.</td>
</tr>
<tr>
<td>i</td>
<td>Repeat this procedure for each network computer you want to access the shared printer.</td>
</tr>
</tbody>
</table>

#### Using the point-and-print method

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Go to a network computer that you want to enable to print to the shared printer.</td>
</tr>
<tr>
<td>b</td>
<td>Insert the printer CD.</td>
</tr>
<tr>
<td>c</td>
<td>Click <strong>Install</strong>.</td>
</tr>
<tr>
<td>d</td>
<td>From the “Connect Your Printer” dialog, select the network option.</td>
</tr>
<tr>
<td>e</td>
<td>From the “Networking Setup” dialog, select <strong>Peer-to-Peer</strong>.</td>
</tr>
<tr>
<td>f</td>
<td>Enter the shared names of both the printer and the network computer you assigned in step 6 on page 90.</td>
</tr>
<tr>
<td>g</td>
<td>When prompted, select <strong>Test Page</strong> to make sure the computer can print to the shared printer.</td>
</tr>
</tbody>
</table>

#### Direct IP printing

1. Connect the printer to an external print server using a USB cable.
2. Connect the print server to the network using an Ethernet cable.

   **Note:** You may be connecting your printer directly into a wall connection or through a router. For more information, see the print server documentation.
3. Insert the printer software CD.
4. Click **Install**.
5. From the “Connect Your Printer” dialog, select the network option.
6. From the “Networking Setup” dialog, select **Direct Network Attached**.
7. Select the printer/print server combination from the Network Printers list.

   **Note:** If more than one is listed, match the MAC address of the print server to the one in the list. For more information, see “Finding your MAC address” on page 92.
Tips for installing a network printer

The following topics will help you install, configure, and troubleshoot the network printer.

**Assigning an IP address**

An IP address is assigned during printer software installation, but only for Direct IP printing. The print object, created at the end of the installation, sends all print jobs across the network to the printer attached to the print server using this address.

Many networks have the ability to automatically assign an IP address. In smaller networks, it is often called Auto-IP. There are two common types of Auto-IP networks. UPnP network environments provide automatic private IP addresses in the 169.254.x.x range. ICS network environments provide automatic private IP addresses in the 192.168.x.x range. Larger networks may use DHCP to assign addresses. These are usually unique to the company.

During the Direct IP printing installation of printer software, the IP address is visible in the printer list only as it is being assigned. The print object that is created in the Printers folder of the operating system will reference the MAC address of the print server in the port name.

If the IP address is not automatically assigned during printer software installation, you can try manually entering an address after selecting your printer/print server from the available list.

**Finding your MAC address**

You may need the media access control (MAC) address of the print server to complete network printer configuration. The MAC address is a series of letters and numbers listed on the bottom of the external print server.

**Configuring a network printer manually**

1. From the “Configure Network Printers” dialog, highlight the printer you want to configure, and then click **Configure**.

2. Select **DHCP** or **Configure IP Address Manually**.

3. Enter the desired IP address, subnet mask, and gateway for the printer.

4. Click **OK**.

**Finding a printer/print server located on remote subnets**

The printer software CD can automatically find the printers that are located on the same network as the computer. If the printer and print server are located on another network (called a subnet), you must manually enter an IP address during printer software installation.

**Network troubleshooting tips**

1. Make sure the printer is set up correctly. For more information, see the printer setup documentation.

2. Make sure all cable connections are secure. For more information, see the printer or print server setup documentation.
3 Make sure the correct lights are showing on the print server. For more information, see the print server documentation.

4 If the printer software CD cannot find the printer/print server, wait a few minutes, and then try running the CD again. Network traffic speeds vary.

5 Make sure the computer you are using to install the printer is connected to the network.

6 See the print server documentation for additional troubleshooting.
Removing a used print cartridge

1 Make sure the printer is on.

2 Lift the scanner unit.
   The print cartridge carrier moves and stops at the loading position, unless the printer is busy.

3 Press down on the lever to raise the cartridge lid.

4 Remove the used print cartridge.
   To recycle the used cartridge, see “Recycling Lexmark products” on page 100.
   If the cartridge you removed is not empty and you want to use it later, see “Preserving the print cartridges” on page 99.

Note: If you are removing both cartridges, repeat steps 3 and 4 for the second cartridge.
Installing print cartridges

1. If you are installing new print cartridges, remove the sticker and tape from the back and bottom of the cartridges.

Warning: Do not touch the gold contact area on the back or the metal nozzles on the bottom of the cartridges.

2. Press down on the cartridge levers to raise the cartridge lids.

3. Insert the black cartridge or the photo cartridge in the left carrier. Insert the color cartridge in the right carrier.

4. Close the lids.
5 Close the scanner unit, making sure to keep your hands out from underneath the scanner unit.

Note: The control panel display will prompt you to print an alignment page. For more information, see “Aligning print cartridges” on page 96.

Note: The scanner unit must be closed to start a new scan, print, copy, or fax job.

**Aligning print cartridges**

Align the print cartridges when you:

- Have installed a new cartridge
- Want to improve print quality

**Aligning print cartridges using the control panel**

1 Load plain paper.

2 From the control panel, press **Copy Mode**.

3 Press ✈.

4 Press ▲ or ▼ repeatedly until **Maintenance** is highlighted.

5 Press ✓.

6 Press ▲ or ▼ repeatedly until **Align Cartridges** is highlighted.

7 Press ✓.

An alignment page prints.

If you aligned the cartridges to improve print quality, print your document again. If print quality has not improved, clean the print cartridge nozzles.

**Aligning the print cartridges using the Productivity Suite**

1 Load plain paper.

2 From the desktop, double-click the **Productivity Suite** icon, and then click **Maintain/Troubleshoot**.
3 Click the **Maintenance** tab.

4 Click **Align to fix blurry edges**.

5 Click **Print**.

   An alignment page prints.

If you aligned the cartridges to improve print quality, print your document again. If print quality has not improved, clean the print cartridge nozzles.

**Cleaning the print cartridge nozzles**

*Cleaning the print cartridge nozzles using the control panel*

1 Load plain paper.

2 Press **Copy Mode**.

3 Press □.

4 Press ▲ or ▼ repeatedly until **Maintenance** is highlighted.

5 Press ✔.

6 Press ▲ or ▼ repeatedly until **Clean Cartridges** is highlighted.

7 Press ✔.

   A page prints, forcing ink through the print cartridge nozzles to clean them.

8 Print the document again to verify that the print quality has improved.

9 If print quality has not improved, try cleaning the nozzles up to two more times.

*Cleaning the print cartridge nozzles using the Productivity Suite*

1 Load plain paper.

2 From the desktop, double-click the **Productivity Suite** icon, and then click **Maintain/Troubleshoot**.

3 Click the **Maintenance** tab.

4 Click **Clean to fix horizontal streaks**.

5 Click **Print**.

   A page prints, forcing ink through the print cartridge nozzles to clean them.

6 Print the document again to verify that the print quality has improved.

7 If print quality has not improved, try cleaning the nozzles up to two more times.
Wiping the print cartridge nozzles and contacts

1. Remove the print cartridges.
2. Dampen a clean, lint-free cloth with water.
3. Gently hold the cloth against the nozzles for about three seconds, and then wipe in the direction shown.
4. Using another clean section of the cloth, gently hold the cloth against the contacts for about three seconds, and then wipe in the direction shown.
5. With another clean section of the cloth, repeat step 3 and step 4.
6. Let the nozzles and contacts dry completely.
7. Reinsert the print cartridges.
8. Print the document again.
9. If the print quality does not improve, clean the print nozzles. For more information, see “Cleaning the print cartridge nozzles” on page 97.
10. Repeat step 9 up to two more times.
11. If print quality is still not satisfactory, replace the print cartridges.

Improving print quality

If you are not satisfied with the print quality of a document, make sure you:

- Use the appropriate paper for the document. For example, use photo paper if you are printing photos or other high quality images.
- Use a paper that is a heavier weight, bright white, or coated.
- Select a higher print quality.
If the document still does not have the print quality you want, follow these steps:

1. Align the print cartridges. For more information, see “Aligning print cartridges” on page 96.
   If print quality has not improved, continue to step 2.

2. Clean the print nozzles. For more information, see “Cleaning the print cartridge nozzles using the control panel” on page 97.
   If print quality has not improved, continue to step 3.

3. Remove and reinsert the print cartridges. For more information, see “Removing a used print cartridge” on page 94 and “Installing print cartridges” on page 95.
   If print quality has not improved, continue to step 4.

4. Wipe the print nozzles and contacts. For more information, see “Wiping the print cartridge nozzles and contacts” on page 98.
   If print quality is still not satisfactory, replace the print cartridges. For more information, see “Ordering supplies” on page 100.

Preserving the print cartridges

- Keep a new cartridge in its packaging until you are ready to install it.
- Do not remove a cartridge from the printer except to replace, clean, or store it in an airtight container. The cartridges do not print correctly if left exposed for an extended period of time.
- Keep the photo cartridge in its own storage unit when not in use.

Cleaning the scanner glass

1. Dampen a clean, lint-free cloth with water.

2. Gently wipe the scanner glass clean.

   **Note:** Make sure all ink or corrective fluid on a document is dry before placing the document on the scanner glass.
Ordering supplies

To order supplies or to locate a dealer near you, visit our Web site at www.lexmark.com.

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black cartridge</td>
<td>32 or 34</td>
</tr>
<tr>
<td>Color cartridge</td>
<td>33 or 35</td>
</tr>
<tr>
<td>Photo cartridge</td>
<td>31</td>
</tr>
<tr>
<td>USB cable</td>
<td>12A2405</td>
</tr>
</tbody>
</table>

Note: For best results, use only Lexmark print cartridges.

Lexmark photo paper types and sizes

- Photo paper (glossy) 4 x 6
- Photo paper (glossy) 8 1/2 x 11
- Photo paper (glossy) A4
- Premium photo paper (high gloss) 4 x 6
- Premium photo paper (high gloss) 8 1/2 x 11
- Premium photo paper (high gloss) A4
- Premium photo paper (high gloss) L

Note: For best results, use Lexmark Premium Photo Paper when printing photos or other high-quality images.

Recycling Lexmark products

To return Lexmark products to Lexmark for recycling:

2. Follow the instructions on the computer screen.
Troubleshooting

- “Setup troubleshooting” on page 101
- “Print troubleshooting” on page 104
- “Copy troubleshooting” on page 107
- “Scan troubleshooting” on page 109
- “Fax troubleshooting” on page 110
- “Network troubleshooting” on page 116
- “Jams and misfeeds troubleshooting” on page 117
- “Memory card troubleshooting” on page 120
- “Error messages” on page 121
- “Removing and reinstalling the software” on page 125

**Setup troubleshooting**

- “Incorrect language appears on the display” on page 101
- “Power button is not lit” on page 102
- “Software does not install” on page 102
- “Page does not print” on page 103
- “Cannot print from digital camera using PictBridge” on page 104

**Incorrect language appears on the display**

1. From the control panel, press **Copy Mode**.

2. Press \[.

3. Press \[ repeatedly until the last menu item is highlighted.

4. Press \[.

5. Press \[ or \[ repeatedly until the second menu item is highlighted.

6. Press \[ or \[ repeatedly until the language you want appears on the display.

7. Press \[.

8. Press \[.
**Power button is not lit**

1. Disconnect the power supply cord from the wall outlet, and then from the printer.
2. Plug the cord all the way into the power supply port on the printer.
3. Plug the cord into an electrical outlet that other electrical devices have been using.
4. If the Power button light is not on, press Power.

**Software does not install**

The following operating systems are supported:
- Windows 98/Me
- Windows 2000
- Windows XP

If the software does not launch automatically when you insert the CD:
1. Close all open software applications.
2. Disable any anti-virus programs.
3. Double-click the My Computer icon.
   - In Windows XP, click Start to access the My Computer icon.
4. Double-click the CD–ROM drive icon.
5. If necessary, double-click setup.exe.
6. Follow the instructions on the computer screen to install the software.

1. Check the USB cable for any obvious damage.
2. Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   - The USB port is marked with the USB symbol.
3. Firmly plug the square end of the USB cable into the back of the printer.
If the printer is connected to the computer through another device:

1. Disconnect the USB cable from any other device, such as a USB hub or switch box.
2. Directly connect the cable to the printer and the computer.

**Page does not print**

If an error message is displayed, see “Error messages” on page 121.

If the Power button light is not on, see “Power button is not lit” on page 102.

Make sure the black or photo cartridge is in the left carrier, and the color cartridge is in the right carrier.

Remove and then load paper.

Check the ink levels, and install a new print cartridge if necessary.

1. Remove the print cartridges.
2. Make sure the sticker and tape have been removed.

3. Reinsert the print cartridges.

If the printer is connected to the computer through another device:

1. Disconnect the USB cable from any other device, such as a USB hub or switch box.
2. Directly connect the cable to the printer and the computer.

Make sure the printer is set as the default printer and is not on hold or paused.

1. Click:
   - In Windows XP Pro: Start → Settings → Printers and Faxes.
   - In Windows XP Home: Start → Control Panel → Printers and Faxes.
   - In Windows 98/Me: Start → Settings → Printers.
2. Double-click the name of your printer.
3 Click **Printer**.
   - Make sure no check mark appears next to Pause Printing.
   - Make sure a check mark does appear next to Set As Default.

1 Press **Power** to turn the printer off.
2 Disconnect the power supply cord from the wall outlet.
3 Gently remove the power supply from the printer.
4 Reconnect the power supply to the printer.
5 Plug the power supply cord into the wall outlet.
6 Press **Power** to turn the printer on.

If none of the previous options fixes the problem, uninstall the printer software, and reinstall it. For more information, see “Removing and reinstalling the software” on page 125.

**Cannot print from digital camera using PictBridge**

Enable PictBridge printing on the camera by selecting the correct USB mode. For more information, see the digital camera documentation.

1 Disconnect the camera.
2 Connect a PictBridge-enabled digital camera to the PictBridge port. See the digital camera documentation to determine whether it is PictBridge-enabled.

Use only the USB cable that came with the camera.

Remove the memory card or the flash drive from the printer.

**Print troubleshooting**

- “Improving print quality” on page 98
- “Poor text and graphic quality” on page 105
- “Poor quality at the edges of the page” on page 106
- “Partial document or photo prints” on page 107
- “Printer does not print or respond” on page 106
- “Print speed is slow” on page 106

**Improving print quality**

If you are not satisfied with the print quality of a document, make sure you:

- Use the appropriate paper for the document. Use Lexmark Premium Photo Paper if you are printing photos or other high quality images.
- Use a paper that is a heavier weight, bright white, or coated.
- Select a higher print quality.
If the document still does not have the print quality you want, follow these steps:

1. Align the print cartridges. For more information, see “Aligning print cartridges” on page 96. If print quality has not improved, continue to step 2.

2. Clean the print nozzles. For more information, see “Cleaning the print cartridge nozzles using the control panel” on page 97. If print quality has not improved, continue to step 3.

3. Remove and reinsert the print cartridges. For more information, see “Removing a used print cartridge” on page 94 and “Installing print cartridges” on page 95. If print quality has not improved, continue to step 4.

4. Wipe the print nozzles and contacts. For more information, see “Wiping the print cartridge nozzles and contacts” on page 98. If print quality is still not satisfactory, replace the print cartridges. For more information, see “Ordering supplies” on page 100.

**Poor text and graphic quality**

Examples of poor text and graphic quality include:

- Blank pages
- Dark print
- Faded print
- Incorrect colors
- Light and dark bands in print
- Skewed lines
- Smudges
- Streaks
- White lines in print

Check the ink levels, and install a new print cartridge if necessary.

See “Improving print quality” on page 104.

To avoid ink smudging when you are working with the following media, remove each sheet as it exits, and allow it to dry:

- Document with graphics or images
- Photo paper
- Coated or glossy paper
- Transparency
- Iron-on transfer

**Note:** Transparencies may take up to 15 minutes to dry.
Use a different brand of paper. Each paper brand accepts ink differently and prints with color variations. Use Lexmark Premium Photo Paper if you are printing photos or other high quality images.

Use only new, unwrinkled paper.

Uninstall the printer software, and then reinstall it. For more information, see “Removing and reinstalling the software” on page 125.

**Poor quality at the edges of the page**

Unless you are using the borderless feature, use these minimum print margin settings:

- Left and right margins:
  - 6.35 mm (0.25 in.) for letter size paper
  - 3.37 mm (0.133 in.) for all paper sizes except letter
- Top margin: 1.7 mm (0.067 in.)
- Bottom margin: 16.51 mm (0.65 in.)

Select the Borderless print feature.

1. From the software application, click **File → Print**.
2. Click **Properties, Options, Setup, or Preferences**.
3. Click **Print Layout**.
4. Click **Borderless**.

Check that the paper size being used matches the printer setting.

1. From the software application, click **File → Print**.
2. Click **Properties, Options, Setup, or Preferences**.
3. Click **Paper Setup**.
4. Check the paper size.

**Printer does not print or respond**

See “Page does not print” on page 103.

**Print speed is slow**

Close all applications not in use.

Try minimizing the number and size of graphics and images in the document.

Consider purchasing more RAM.

Remove as many unused fonts as possible from your system.
1 From the software application, click File → Print.

2 Click Properties, Options, Setup, or Preferences.

3 Click Quality/Copies.

4 From the Quality/Speed area, select a lower print quality.

**Partial document or photo prints**

Make sure the document or photo is loaded correctly on the scanner glass.

Make sure the paper size being used matches the size you selected.

**Copy troubleshooting**

- “Copier does not respond” on page 107
- “Scanner unit does not close” on page 107
- “Poor copy quality” on page 108
- “Partial document or photo copies” on page 108

**Copier does not respond**

If the Power button light is not on, see “Power button is not lit” on page 102.

If an error message is displayed, see “Error messages” on page 121.

Make sure the printer is set as the default printer and is not on hold or paused.

1 Click Start → Control Panel → Printers and Other Hardware → Printers and Faxes.

   or

   Click Start → Settings → Printers and Faxes (or Printers).

2 Double-click the name of your printer.

3 Click Printer.

   - Make sure no check mark appears next to Pause Printing.
   - Make sure a check mark does appear next to Set As Default.

If none of the previous options fixes the problem, uninstall the printer software, and reinstall it. For more information, see “Removing and reinstalling the software” on page 125.

**Scanner unit does not close**

1 Lift the scanner unit.

2 Remove any obstruction keeping the scanner unit open.

3 Lower the scanner unit.
**Poor copy quality**

Examples include:
- Blank pages
- Checkerboard pattern
- Distorted graphics or pictures
- Missing characters
- Faded print
- Dark print
- Skewed lines
- Smudges
- Streaks
- Unexpected characters
- White lines in print

If an error message is displayed, see “Error messages” on page 121.

Check the ink levels and install a new print cartridge if necessary.

If the scanner glass is dirty, gently wipe it with a clean, lint-free cloth dampened with water.

See “Improving print quality” on page 98.

To adjust the Brightness setting:

1. Load the document face down on the scanner glass.
2. From the control panel, press **Copy Mode**.
3. Press ▲ or ▼ repeatedly until **Lighter / Darker** is highlighted.
4. Press ◀ or ▶ to lighten or darken the copy.
5. Press ✓.

If you are copying or scanning from a newspaper, magazine, or glossy paper, see “Scanning clear images from magazines or newspapers” on page 75.

If the quality of the original is not satisfactory, try using a clearer version of the document or image.

Place the document face down on the scanner glass.

**Partial document or photo copies**

Make sure the document or photo is loaded correctly in the ADF or on the scanner glass.

Make sure the paper size being used matches the size you selected.
Scan troubleshooting

- “Scanner does not respond” on page 109
- “Scanning takes too long or freezes the computer” on page 109
- “Scan was not successful” on page 110
- “Partial document or photo scans” on page 110
- “Cannot scan to an application” on page 110
- “Cannot scan to a computer over a network” on page 110

**Scanner does not respond**

If an error message is displayed, see “Error messages” on page 121.

If the Power button light is not on, see “Power button is not lit” on page 102.

Make sure the printer is set as the default printer and is not on hold or paused.

1. Click:
   - In Windows XP Pro: **Start → Settings → Printers and Faxes**.
   - In Windows XP Home: **Start → Control Panel → Printers and Faxes**.
   - In Windows 2000: **Start → Settings → Printers**.
   - In Windows 98/Me: **Start → Settings → Printers**.

2. Double-click the name of your printer.

3. Click **Printer**.
   - Make sure no check mark appears next to Pause Printing.
   - Make sure a check mark does appear next to Set As Default.

If none of the previous options fixes the problem, uninstall the printer software, and reinstall it. For more information, see “Removing and reinstalling the software” on page 125.

**Scanning takes too long or freezes the computer**

Close all programs not being used.

To change the scanning resolution to a lower value:

1. Click **Start → Programs** or **All Programs → Lexmark 8300 Series**.

2. Select **All-In-One Center**.

3. From the Scan area, click **See More Scan Settings**.

4. Click **Display Advanced Scan Settings**.

5. From the Select Scan Resolution menu, select a lower number.
**Scan was not successful**

1. Restart the computer.

2. Remove and reinstall the software. For help, see “Removing and reinstalling the software” on page 125.

**Partial document or photo scans**

Make sure the document or photo is loaded correctly in the ADF or on the scanner glass.

Make sure the paper size being used matches the size you selected.

**Cannot scan to an application**

1. From the Selected Application Does Not Support Multiple Pages dialog, click **Cancel**.

2. From the All-In-One Center Scanning and Copying tab, choose a different application from the “Send scanned image to” menu.

3. Scan the document.

**Cannot scan to a computer over a network**

See “Scanning to a computer over a network” on page 75.

**Fax troubleshooting**

- “Cannot send or receive a fax” on page 110
- “Can send but not receive faxes” on page 112
- “Can receive but not send faxes” on page 113
- “Printer receives a blank fax” on page 114
- “Received fax has poor print quality” on page 114
- “Error message: **Fax error**” on page 115
- “Error message: **Fax mode unsupported**” on page 115

If faxing using the Productivity Suite, make sure:
  - The printer is connected to a computer that is equipped with a fax modem.
  - The computer is connected to a working phone line.
  - Both the printer and the computer are turned on.

For additional help when you are using a fax application, see the documentation that came with the fax application.

**Cannot send or receive a fax**

If an error message appears, follow the instructions on the error message dialog.
If the Power light is not on, see “Power button is not lit” on page 102.

Make sure cable connections for the following hardware are secure, if applicable:

- Power supply
- Telephone
- Handset
- Answering machine

Check the telephone wall jack.

1. Plug a telephone into the wall jack.
2. Listen for a dial tone.
3. If you do not hear a dial tone, plug a different telephone into the jack.
4. If you still do not hear a dial tone, connect the printer to a different telephone jack.

Place a test call to the telephone number to which you want to send a fax to make sure that it is working correctly.

The fax modem is an analog device. Certain devices can be connected to the printer so that digital telephone services can be used.

- If you are using an ISDN telephone service, connect the printer to an analog telephone port (an R-interface port) on an ISDN terminal adapter. For more information and to request an R-interface port, contact your ISDN provider.
- If you are using a DSL telephone, connect to a DSL filter or router that will support analog use. For more information, contact your DSL provider.
- If you are using a PBX telephone service, make sure you are connecting to an analog connection on the PBX. If none exists, consider installing an analog telephone line for the fax machine.

If the telephone line is being used by another device, wait until the other device is finished before sending a fax.

If using the On Hook Dial feature, turn up the volume to verify a dial tone.

To ensure the printer is working correctly, connect it directly to the telephone line. Disconnect any answering machines, computers with modems, or telephone line splitters.

Check for and clear any paper jams.

Make sure both the black and color print cartridges are installed. The printer works only if both print cartridges are installed.

Call Waiting can disrupt fax transmissions. Disable this feature before sending or receiving a fax. Call your telephone company to obtain the keypad sequence for temporarily disabling Call Waiting.

Voice Mail offered through your local telephone company may disrupt fax transmissions. To enable both Voice Mail and the printer to answer calls, see “Setting the distinctive ring using the control panel” on page 85. Setting selections include single ring, double ring, triple ring, and any ring.
Make sure the country code has been set for the country or region where you are operating the printer:

1. From the control panel, press **Fax Mode**.
2. Press \(\text{Fax} \) .
3. Press \(\uparrow\) or \(\downarrow\) repeatedly until **Device Defaults** is highlighted.
4. Press \(\checkmark\).
5. Press \(\uparrow\) or \(\downarrow\) repeatedly until **Country** is highlighted.
6. Press \(\leftarrow\) or \(\rightarrow\) repeatedly until the country where you are operating the printer appears.
7. Press \(\checkmark\).
8. Press \(\leftrightarrow\).

If the printer memory is full:

1. Dial the receiving number.
2. Scan the original document one page at a time.

**Can send but not receive faxes**

Load paper to print any faxes that have been stored in the printer.

Check the status of the Auto Answer feature.

If the Auto Answer light is on, the printer will answer after the preset number of telephone rings. Setting selections include single ring, double ring, triple ring, and any ring. See “Setting the distinctive ring using the control panel” on page 85.

Check the ink levels, and install a new cartridge if necessary.

Check to see whether Fax Forwarding is selected.

1. Press **Fax Mode**.
2. Press \(\text{Fax} \) .
3. Press \(\uparrow\) or \(\downarrow\) repeatedly until **Ringing and Answering** is highlighted.
4. Press \(\checkmark\).
   - **Fax Forwarding** is highlighted.
5. Press \(\leftarrow\) or \(\rightarrow\) repeatedly to view the current Fax Forwarding setting.
6. To turn Fax Forwarding off, press \(\leftarrow\) or \(\rightarrow\) repeatedly until **Off** appears.
Can receive but not send faxes

To make sure the printer is set for faxing, press Fax Mode.

Load the original document face down in the upper left corner of the scanner glass or text-side up in the ADF.

Check the Dial Prefix setting.

1 Press Fax Mode.
2 Press .
3 Press ▲ or ▼ repeatedly until Dialing and Sending is highlighted.
4 Press ✓.
5 Press ▲ or ▼ repeatedly until Dialing Prefix and the current Dial Prefix setting are highlighted.
6 To change the setting, press ▼ or ▲ repeatedly until Modify is highlighted.
7 Press ✓.
8 Enter the numbers you would like to have dialed before each telephone number.
9 Press ✓.
10 Press .

If you used a Speed Dial button:

1. Check to make sure it has been programmed for the number that you wish to dial. See “Setting up Speed Dial” on page 80.
2. As an alternative, dial the telephone number manually.

Make sure the printer is detecting a dial tone.

1. See “Faxing while listening to a call (On Hook Dial)” on page 84.
2. Check the Dial Method setting.
   1 Listen for a dial tone. If you hear a dial tone but the printer hangs up without dialing, this means it did not recognize the dial tone.
2 Press Fax Mode.
3 Press .
4 Press ▼ or ▲ repeatedly until Dialing and Sending is highlighted.
5 Press ✓.
6 Press ▼ or ▲ repeatedly until Dial Method is highlighted.
7 Press ← or → to select one of the following: **Touch Tone, Pulse, or Behind a PBX.**

8 Press ✓.

9 Press ↵.

**Printer receives a blank fax**

Ask the sender to verify the original document was loaded correctly.

Check the ink levels, and install a new cartridge if necessary.

1 Remove the print cartridges.

2 Make sure the sticker and tape have been removed.

3 Reinsert the print cartridges.

**Received fax has poor print quality**

Ask that the sender:

- Check that the quality of the original document is satisfactory.
- Resend the fax. There may have been a problem with the quality of the telephone line connection.
- Increase the fax scan resolution.

Change the fax quality setting:

1 Press **Fax Mode**.

2 Press ☰.

3 Press ▲ or ▼ repeatedly until **Quality** is selected.

4 Press ← or → repeatedly to select a higher fax quality.

5 Press ✓.

6 Press ↵.
Check the ink levels and install a new cartridge if necessary.

Decrease the transmission speed.

1 Press **Fax Mode**.
2 Press ▪.
3 Press ▼ or ▲ repeatedly until **Dialing and Sending** is highlighted.
4 Press √.
5 Press ▼ or ▲ repeatedly until **Max Send Speed** is highlighted.
6 Press ◀ or ▶ until **14,400** appears.
7 Press √.
8 If the problem persists, repeat step 1–step 6 until **9600** appears.
9 Press √.
10 If the problem still persists, repeat step 1–step 6 until **2400** appears.
11 Press √.
12 Press ⏯.

**Notes:**
- The lower the transmission speed, the longer it will take your fax to print.
- This solution will reduce the speed for future faxes until you reset the transmission speed.

**Error message: Fax error**

The fax machines have stopped communicating.
Resend the fax. There may have been a problem with the quality of the telephone line connection.

**Error message: Fax mode unsupported**

The receiving fax machine does not support the type of fax you attempted to send. If it does not support:
- Your scan resolution—lower the scan resolution.
1 Press **Fax Mode**.
2 Press ▪.
3 Press ▼ or ▲ repeatedly until **Quality** is highlighted.
4 Press ◀ or ▶ repeatedly until **Standard** or **Fine** appears.
Network troubleshooting

- “The printer to be configured does not appear in the list of printers found on your network” on page 116
- “You cannot print to the network printer” on page 117
- “Network name does not appear in the list” on page 117

The printer to be configured does not appear in the list of printers found on your network

SSID is not being broadcast. Make sure security keys are correct.

Make sure the printer is connected to a power source and is turned on. For more information, see “Power button is not lit” on page 102.

If you are using a print server:

1. Check the Ethernet cable for any obvious damage.
2. Firmly plug one end of the Ethernet cable into the printer or the print server.
3. Firmly plug the other end of the Ethernet cable into the network hub or wall connection.

If you are also using a USB cable:

1. Check the USB cable for any obvious damage.
2. Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol 🛜.
3. Firmly plug the square end of the USB cable into the USB port on the back of the printer.

See the print server documentation for setup instructions if:

- The lights of the print server are not on.
- The USB cable is not connected to the print server.
- The print server is not connected to a power source.

If none of the previous actions fixes the problem, uninstall the printer software, and reinstall it. For more information, see “Removing and reinstalling the software” on page 125.
You cannot print to the network printer

See the print server documentation for setup instructions if:

- The lights of the print server are not on.
- The USB cable is not connected to the print server.
- The print server is not connected to a power source.

1 Check the Ethernet cable for any obvious damage.
2 Firmly plug one end of the Ethernet cable into the printer.
3 Firmly plug the other end of the Ethernet cable into the network hub or wall connection.

If you are also using a USB cable:

1 Check the USB cable for any obvious damage.
2 Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol 📥.
3 Firmly plug the square end of the USB cable into the USB port on the back of the printer.

Contact your system support person to make sure the printer is connected to a working network connection.

Make sure the printer is connected to a power source and is turned on. For more information, see “Power button is not lit” on page 102.

Network name does not appear in the list

SSID is not being broadcast. Make sure security keys are correct.

Jams and misfeeds troubleshooting

- “Paper jam in the printer” on page 117
- “Paper jam in the ADF” on page 118
- “Paper or specialty media misfeeds” on page 118
- “Printer does not feed paper, envelopes, or specialty media” on page 119
- “Banner paper jams” on page 119

Paper jam in the printer

To remove the paper:

1 Open the rear door.
2 Firmly grasp the paper, and gently pull it out.
3 Close the rear door.

4 Press √.

If the paper is accessible from the front of the printer:

1 Raise the paper exit tray.

2 Firmly grasp the paper, and gently pull it out.

3 Lower the paper exit tray.

4 Press √.

**Paper jam in the ADF**

1 Open the ADF.

2 Firmly grasp the paper, and gently pull it out.

3 Close the ADF.

4 Press √.

**Paper or specialty media misfeeds**

If paper or specialty media misfeeds or skews, or multiple sheets feed or stick together, try the following solutions.

Load a smaller amount of paper into the printer.

See “Loading various paper types” on page 44 for information about:

- Maximum loading amounts per paper type
- Specific loading instructions for supported paper and specialty media

Load paper with the print side facing down.

Remove each page as it exits, and let it dry completely before stacking.

Use only new, unwrinkled paper.
Adjust the paper guides:
- When using media less than 8.5 inches wide
- Against the edges of the paper or media, making sure it does not buckle

**Printer does not feed paper, envelopes, or specialty media**

If there is a paper jam, see the appropriate paper jam section.

Verify that the specialty media is loaded correctly.

Try loading one page, envelope, or sheet of specialty media at a time.

Make sure the printer is set as the default printer and is not on hold or paused.

1. Click **Start** → **Control Panel** → **Printers and Other Hardware** → **Printers and Faxes**.
   or
   Click **Start** → **Settings** → **Printers and Faxes** (or Printers).

2. Double-click the name of your printer.

3. Click **Printer**.
   - Make sure no check mark appears next to Pause Printing.
   - Make sure a check mark does appear next to Set As Default.

**Banner paper jams**

1. Press **Power** to turn off the printer.

2. Remove the jammed banner paper from the printer.

To keep a banner print job from jamming:

- Use only the number of sheets needed for the banner.
- Select the following settings to enable the printer to feed paper continuously without jamming:
  1. With a document open, click **File** → **Print**.
  2. Click **Properties**, **Options**, **Setup**, or **Preferences**.
3 Select the Paper Size tab.
4 From the Paper Size area, select Banner.
5 Select Letter Banner or A4 Banner as the paper size.
6 From the Print Layout tab, select Banner.

Memory card troubleshooting

- “Memory card cannot be inserted” on page 120
- “Nothing happens when a memory card is inserted” on page 120
- “Error messages on display” on page 121

Memory card cannot be inserted

Make sure that the type of memory card you are using can be used in the printer. See “Inserting a memory card” on page 54 to determine which slot accommodates your memory card and to see instructions on how to insert it.

Nothing happens when a memory card is inserted

Remove and reinsert the memory card quickly.

Warning: Do not remove cables, photo storage devices, or touch the printer in the area shown while the light is blinking.

See “Inserting a memory card” on page 54 to determine which slot accommodates your memory card and to see instructions on how to insert it.

Make sure that the type of memory card you are using can be used in the printer. See “Inserting a memory card” on page 54.

Check that there is no obvious damage to the memory card.

Insert only one memory card at a time.

Disconnect the PictBridge-enabled digital camera or flash drive from the printer.
Check the cable connections.

1. Check the USB cable for any obvious damage.

2. Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol.

3. Firmly plug the square end of the USB cable into the back of the printer.

Error messages on display

If an error message is displayed, see “Error messages” on page 121.

Error messages

Low Ink

1. Check the ink levels and install a new cartridge if necessary. The Low Ink warning occurs when the cartridge is 25% full, 15% full, and 10% full.
   To order supplies, see “Ordering supplies” on page 100.

2. Press \( \sqrt{ } \) to continue.

Paper Jam

See “Jams and misfeeds troubleshooting” on page 117.

Cartridge Error

This includes the following cartridge errors:

- 1105
- 1203
- 1204
- 1205
- 1206

Procedure 1

1. Remove the print cartridges.

2. Disconnect the power supply cord from the electrical outlet.

3. Reconnect the power supply cord to the electrical outlet.

4. If the power button is not lit, press Power.

5. Reinsert the print cartridges.
If the error:
  • Does not reappear, the problem has been corrected.
  • Reappears, one of the cartridges is not working properly. Continue with Procedure 2.

Procedure 2
Follow this procedure to determine which cartridge is not working properly.

1 Remove the print cartridges.
2 Disconnect the power supply cord from the electrical outlet.
3 Reconnect the power supply cord to the electrical outlet.
4 If the power button is not lit, press Power.
5 Reinsert the black (or photo) print cartridge.
6 If the error:
   • Reappears, replace the black (or photo) print cartridge with a new one.
   • Does not reappear, reinsert the color print cartridge.
7 If the error reappears, replace the color print cartridge with a new one.

Carrier Jam

1 Raise the scanner unit.
2 Remove any objects blocking the path of the cartridge carrier.
3 Make sure the cartridge lids are closed.
4 Close the scanner unit.
5 Press √.

Error: 2200

1 Raise the scanner unit.
2 Remove any objects blocking the path of the cartridge carrier.
3 Make sure the cartridge lids are closed.

4 Close the scanner unit.

5 Press √.

**Paper Out**

1 Load paper.

2 Press √.

**Cartridge Missing**

One or more cartridges are missing or not installed properly. For more information, see “Installing print cartridges” on page 95.

**Alignment Error**

1 Remove the print cartridges.

2 Make sure the sticker and tape have been removed.

3 Reinsert the print cartridges.

4 Press √ to align the cartridges.

Load only plain, unmarked paper for aligning cartridges.

The printer will read any markings on used paper, which could cause the alignment error message to appear.
**Photo Mode: problem reading memory card**

The memory card was inserted incorrectly or is damaged.

1. Check for any obvious damage to the memory card.
2. Reinsert the memory card. See "Inserting a memory card" on page 54 to determine which slot accommodates your memory card and to see instructions on how to insert it.

**Photo Mode: second memory card detected**

The printer can read only one memory card at a time.

1. Remove both memory cards.
2. Reinsert only one memory card.

**Photo Mode: no images found**

No supported images have been found on the memory card.

1. Remove the memory card.
2. Use only memory cards containing photos created in your digital camera using the JPEG format.
   
   For more information, see the documentation that came with your camera.

**~filename .jpg file appears**

When the process of copying files to a memory card is interrupted, temporary files may appear on the memory card. Temporary files usually begin with the "~" symbol.

Delete these files using the digital camera or computer.

**Card format**

The memory card format is not recognized by the printer.

1. Remove the memory card.
2. Format the memory card in your digital camera using the JPEG format. For more information, see the documentation that came with your camera.

**DPOF Error: no images found**

One or more images in the DPOF file could not be found.

Press ✓ to finish the print job without those images, or press ✗ to end the print job.
**DPOF Error: photo larger than paper size**

There are one or more photos larger than the Blank Paper Size you selected.

1. Press √.
2. Choose a new Blank Paper Size to fit the largest photo size.

**Sepia Warning**

Sepia Tone Print is available only with color printing.

Press Start Color to continue, or ✗ to change photo settings.

**No Computer**

Make sure your computer is connected and turned on.

1. Check the USB cable for any obvious damage.
2. Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the ⚙ USB symbol.
3. Firmly plug the square end of the USB cable into the USB port on the back of the printer.

**Removing and reinstalling the software**

If the printer is not functioning properly, or if a communications error message appears when you try to use the printer, you may need to remove and reinstall the printer software.

1. Click Start → Programs or All Programs → Lexmark 8300 Series.
2. Select Uninstall.
3. Follow the instructions on the computer screen to remove the printer software.
4. Restart the computer before reinstalling the printer software.
5. Click Cancel on all New Hardware Found screens.
6. Insert the CD, and then follow the instructions on the computer screen to reinstall the software.
Notices

Trademarks
Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United States and/or other countries.
Other trademarks are the property of their respective owners.

Conventions
Note: A note identifies something that could help you.
CAUTION: A caution identifies something that could cause you harm.
Warning: A warning identifies something that could damage your product hardware or software.

Copyright advisory
It may be illegal to copy certain materials without permission or license, including documents, images, and currency. If you are not sure whether you have permission, seek legal advice.

Electronic emission notices

Federal Communications Commission (FCC) compliance information statement
The Lexmark™ 8300 Series, type 4419, has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device, use a properly shielded and grounded cable such as Lexmark part number 12A2405
for USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

**Industry Canada compliance statement**

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

**Avis de conformité aux normes de l’industrie du Canada**

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

**European Community (EC) directives conformity**

This product is in conformity with the protection requirements of EC Council directives 89/336/EEC, 73/23/EEC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility and safety of electrical equipment designed for use within certain voltage limits and on radio equipment and telecommunications terminal equipment.

A declaration of conformity with the requirements of the directives has been signed by the Director of Manufacturing and Technical Support, Lexmark International, Inc., S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

**Japanese VCCI notice**

If this symbol appears on your product, the accompanying statement is applicable.

![VCCI logo](image)

この装置は、情報処理装置等電波障害自主規制協議会(VCCI)の基準に基づくクラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。取扱説明書に従って正しい取り扱いをしてください。

**Korean MIC statement**

If this symbol appears on your product, the accompanying statement is applicable.

![MIC logo](image)

이 기기는 가정용으로 전자파적합등록을 한 기기로서 주거지역에서는 물리적, 전기적 특성上 모든 지역에서 사용할 수 있습니다.

This equipment has undergone EMC registration as a household product. It can be used in any area, including a residential area.
Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

<table>
<thead>
<tr>
<th>1-meter average sound pressure, dBA</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>48</td>
</tr>
<tr>
<td>Scanning</td>
<td>40</td>
</tr>
<tr>
<td>Copying</td>
<td>41</td>
</tr>
</tbody>
</table>

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for your local sales office phone number.

USB flash drives

The current versions of the following USB flash drives have been tested for use with the All-In-One:
- Dell 256 MB High Speed USB 2.0 Memory Key (P/N 311-4341)
- Dane-Elec zMate 128 MB Pen Drive (P/N DA-ZMP2-0128)

Other telecommunications notices

Notice to users of the Canadian telephone network

This product meets the applicable Industry Canada technical specifications. The Ringer Equivalence Number (REN) is an indication of the maximum number of terminals allowed to be connected to a telephone interface. The terminus of an interface may consist of any combination of devices, subject only to the requirement that the sum of the RENs of all the devices does not exceed five. The modem REN is located on the rear of the equipment on the product labeling.
Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is recommended that the customer install an appropriate AC surge arrester in the AC outlet to which this device is connected. An appropriate AC surge arrester is defined as one that is suitably rated, and certified by UL (Underwriter’s Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical surges.

This equipment uses CA11A telephone jacks.

**Notice to users of the New Zealand telephone network**

The following are special conditions for the Facsimile User Instructions. The grant of a telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection to its network. It indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work correctly in all respects with another item of telepermitted equipment of a different make or model, nor does it imply that any product is compatible with all of Telecom’s network services.

This equipment shall not be set up to make automatic calls to the Telecom's 111 Emergency Service.

This equipment may not provide for the effective hand-over of a call to another device connected to the same line.

This equipment should not be used under any circumstances that may constitute a nuisance to other Telecom customers.

Some parameters required for compliance with Telecom's telepermit requirements are dependent on the equipment associated with this device. The associated equipment shall be set to operate within the following limits for compliance to Telecom's specifications:

- There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual call initiation, and
- The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the beginning of the next call attempt.
- The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is not less than 5 seconds between the end of one call attempt and the beginning of another.

**South Africa telecommunications notice**

This modem must be used in conjunction with an approved surge protection device when connected to the PSTN.

**Using this product in Germany**

This product requires a German billing tone filter (Lexmark part number 14B5123) to be installed on any line which receives metering pulses in Germany. Metering pulses may or may not be present on analog lines in Germany. The subscriber may request that metering pulses be placed on the line, or can have them removed by calling the German network provider. Normally, metering pulses are not provided unless specifically requested by the subscriber at the time of installation.
Using this product in Switzerland

This product requires a Swiss billing tone filter (Lexmark part number 14B5109) to be installed on any line which receives metering pulses in Switzerland. The Lexmark filter must be used, as metering pulses are present on all analog telephone lines in Switzerland.

Power consumption

ENERGY STAR

The EPA ENERGY STAR Office Equipment program is a partnership effort with office equipment manufacturers to promote the introduction of energy-efficient products and to reduce air pollution caused by power generation.

Companies participating in this program introduce products that power down when they are not being used. This feature will cut the energy used by up to 50 percent. Lexmark is proud to be a participant in this program.

As an ENERGY STAR Partner, Lexmark International, Inc. has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

Product power consumption

The following table documents the power consumption characteristics of the product.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Power consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>Product is generating hard copy output</td>
<td>17.0 W</td>
</tr>
<tr>
<td>Copying</td>
<td>Product is generating hard copy output from hard copy originals</td>
<td>15.0 W</td>
</tr>
<tr>
<td>Scanning</td>
<td>Product is scanning hard copy documents</td>
<td>14.0 W</td>
</tr>
<tr>
<td>Ready</td>
<td>Product is waiting for a print job</td>
<td>7.5 W</td>
</tr>
<tr>
<td>Power Saver</td>
<td>Product is in energy saving mode</td>
<td>7.5 W</td>
</tr>
<tr>
<td>Off</td>
<td>Product is plugged into a wall outlet, but switch is turned off</td>
<td>6.5 W</td>
</tr>
</tbody>
</table>

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous power draws may be substantially higher than the average.
**Power Saver**

As part of the ENERGY STAR program, this printer is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the EPA Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during periods of inactivity. The period of time between the last operation and entering Power Saver is called the Power Saver Timeout. For this product, the Power Saver Mode is entered after 30 minutes.

**Off mode**

This printer has an off mode which still consumes a small amount of power. To completely stop printer power consumption, disconnect the power supply from the wall outlet.

**Total energy usage**

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode’s energy usage.

**Mercury statement**

This product contains mercury in the lamp (<5mg Hg). Disposal of mercury may be regulated due to environmental considerations. For disposal or recycling information, contact your local authorities or the Electronic Industries Alliance: www.eiae.org.
Index

A
adding text captions 65
ADF
  exit tray 21
  input tray 21
  loading original documents 47
  paper capacity 47
  scanning multiple pages 71
album page, creating 64
aligning print cartridges
  using the control panel 96
  using the Productivity Suite 96
alignment error 123
All-In-One Center
  Maintain/Troubleshoot link 35
  opening 34
  Saved Images tab 36
  Scanning and Copying tab 35
  using 34
answering machine
  receiving a fax with 79
  assigning IP address 92
  Attach to E-mail button 34
Automatic Document Feeder (ADF) 21

B
banner paper
  jams 119
  loading 46
banner, printing 53
blocking host fax settings 89
borderless copies
  using the control panel 69
  using the software 69
borderless photos, printing 63
box contents 13
brightness, adjusting 61
Brightness
  Fax menu 28
  Photo Edit menu 31
browsing and selecting photos
  from the computer 64
  from flash drives 56
  from memory cards 56
buttons, control panel
  Back 25
  Cancel 25
  Copy Mode 23
  Down arrow 24
Fax Auto Answer 24
Fax Mode 23
keypad 25
Left arrow 24
Menu 25
Phone Book 24
Photo Card 23
Power 25
Quick Dial buttons 23
Redial/Pause 24
Right arrow 24
Scan Mode 23
Select 24
Start Black 25
Start Color 25
Up arrow 24
buttons, Productivity Suite
  Attach to E-mail 34
Copy 34
Fax 34
Maintain/Troubleshoot 34
Manage Documents 34
Manage Photos 34
Online Tutorial 34
Scan 34
Scan & Edit Text (OCR) 34
Scan to PDF 34
Tips 34
using 34
Web site 34
Visit Us Online 34

cleaning print cartridge nozzles
  using the control panel 97
  using the Productivity Suite 97
coated paper, loading 44
collating copies 50, 68
  using the computer 68
  using the control panel 67
configuring network printer 92
connecting the printer to
  answering machine 17
  computer modem 18
  telephone 16
  telephone wall jack 15
Contact Information tab 38
contents, box 13
control panel 22
copy settings 26
  fax settings 28
  installing another language 14
  photo settings 29
  scan settings 27
  using 23
copier does not respond 107
Copy
  button 34
  section 36
copy troubleshooting
  copier does not respond 107
  partial document or photo copies 108
  poor copy quality 108
  scanner unit does not close 107
copying
  borderless photos 68
  cloning an image 67
  customizing settings 26
  enlarging an image 70
  reducing an image 70
  repeating an image 67
  using the control panel 66
  using the software 66
cropping photos 61
custom size paper, loading 45
customizing settings
  Copy 26
  Fax 28
  Fax Setup Utility 87
  Photo 29
  Scan 27
D

defaults
  Copy 27
  Fax Mode menu 28
  Photo Card Mode menu 29
  photo print settings, changing 60
digital camera (PictBridge-enabled) 58
direct IP printing 91
distinctive ring patterns 85
documents
  faxing 77
  loading into ADF 47
  loading on scanner glass 48
  printing 50
  scanning documents to edit
text 74
  scanning to e-mail, using the
computer 74
  scanning to e-mail, using the
control panel 73
DPOF error: no images found 124
DPOF error: photo larger than
paper size 125
DPOF settings 60
duplexing 38

E
e-mailing documents or photos
  using control panel 73
  using the computer 74
editing 74
document text (OCR) 74
  scanned images 75
emission notices 126
  enlarging an image using the
control panel 70
envelopes
  loading 44
  printing 51
  error 2200 122
error messages
  alignment error 123
  card format 124
  carrier jam 122
  cartridge error 121
  cartridge missing 123
  DPOF error: no images
  found 124
  DPOF error: photo larger than
paper size 125
  error 2200 122
  low ink 121
  no computer 125
  paper jam 121
  paper out 123
  photo mode: no images
  found 124
  photo mode: problem reading
memory card 124
  photo mode: second memory card
detected 124
  sepia warning 125
  ~filename.jpg file appears 124

F
Fast Pics 40
fax
  activity reports 88
  customizing settings 28, 87
  forwarding 85
  receiving automatically 78
  receiving manually 79
  Fax button 34
  fax settings
    blocking unwanted changes 89
  Fax Setup Utility
    Connection/Dialing tab 87
    customizing settings 87
    Receive tab 87
    Send tab 87
    Speed Dial tab 87
  using 40, 87
fax troubleshooting
  can receive but not send fax 113
  can send but not receive fax 112
  cannot send or receive fax 110
  error message: fax error 115
  error message: fax mode
  unsupported 115
  printer received blank page 114
  received fax has poor print
quality 114
faxing
  getting the printer ready to fax 14
  sending broadcast faxes 82
  sending scheduled faxes 82
  sending while behind a PBX 85
  setting up speed dial 81
  using an application 78
  using the control panel 77
  using the software 78
  while listening to call 84

G
  flash drive
    browsing and selecting
photos 56
    inserting 55
    printing photos from 59
    transferring photos from 57
    forwarding a fax 85

glossy paper, loading 44
greeting cards
  loading 46
  printing 50

H
  How To tab 37

I
I Want To menu 38
  improving print quality 98
  incorrect language appears on the
display 101
  index cards
    loading 46
    printing 50
  information, finding 11
  inserting
    flash drives 55
    memory cards 54
    PictBridge-enabled camera 58
  installing
    network printer 92
    print cartridges 95
    printer software 125
    software and sharing printer on
  network 90
  IP address, assigning 92

J
  jams and misfeeds
  troubleshooting 117
  banner jams 119
  paper jam in printer 117
  paper jam in ADF 118
  paper or specialty media
  misfeeds 118
  printer does not feed paper,
envelopes, or specialty
  media 119
  junk faxes, blocking 86
L
labels, loading 45
landscape orientation, selecting 38
last page first 52
layout, selecting 38
letterhead paper, loading 44
LINE port 23
loading
banner paper 46
coated paper 44
custom size paper 45
documents into the ADF 47
documents on the scanner glass 48
envelopes 44
glossy paper 44
greeting cards 46
index cards 46
labels 45
letterhead paper 44
paper 42, 44
photo cards 46
photo paper 44
photos on the scanner glass 48
postcards 46
premium paper 44
transparencies 45
low ink error 121

M
MAC address, finding 92
magazine articles, loading on the scanner glass 48
Maintain/Troubleshoot button 34
link 35
Maintenance menus
Copy menu 26
Fax menu 28
Photo Card Mode menu 29
Scan menu 27
Maintenance tab 38
Manage Documents button 33
Manage Photos button 33
memory card
browsing and selecting photos 56
inserting 54
printing from 59
transferring photos from 57
memory card slots 21
memory card troubleshooting 120
error messages on display 121

memory card cannot be inserted 120
nothing happens when memory card is inserted 120
multiple pages, scanning using the control panel 71

N
network printer configuring 92
installing 92
network scanning 75
network troubleshooting 116
cannot print to network printer 117
network name not appearing 117
printer to be configured does not appear in list of printers found on your network 116
tips 92
networking
using a print server 91
using the peer-to-peer method 91
using the point-and-print method 91
newspapers, loading on the scanner glass 48
photocards 46
no computer error 125

OCR, editing document text 74
On Hook Dial feature 84
Online Tutorial button 34
ordering supplies 100
orientation, changing
landscape 38
portrait 38

P
page does not print 101
paper exit tray 21
paper jam error 121
paper out error 123
Paper Setup tab
changing orientation 38
changing paper size 38
paper sizes, specifying 38
paper tray 21
paper, loading 42, 44
partial document or photo copies 108
partial document or photo scans 110

parts
ADF exit tray 21
ADF input tray 21
Automatic Document Feeder (ADF) 21
custom size paper 45
control panel 22
EXT port 22
LINE port 23
memory card slots 21
paper exit tray 21
paper tray 21
PictBridge port 21
power supply port 22
rear access door 22
scanner unit 22
top cover 21
USB port 22
peer-to-peer method 91
Photo Card Mode menu 29
photo cards, loading 46
Photo Editor, using 40
photo mode error
no images found 124
problem reading memory card 124
second memory card detected 124
photo paper, loading 44
photos
adding text captions 65
album page 64
browsing and selecting from computer 64
browsing and selecting from memory card or flash drive 56
changing the default photo print settings 60
cropping 61
customizing settings 29
loading on the scanner glass 48
printing 59, 63
printing borderless 63
printing from control panel 59
printing from PictBridge-enabled camera 58
scrapbook page 64
transferring from memory cards or flash drives 57
viewing slide show 60
PictBridge port 21
PictBridge-enabled camera, printing photos from 58
point-and-print method 91
poor copy quality 108
portrait orientation, selecting 38
postcards
loading 46
printing 50
power button is not lit 101
power supply port 22
premium paper, loading 44
Preview section 36
previewing photos 30
from the control panel 30
from the computer 36
print cartridge nozzles,
cleaning 97
print cartridges
aligning 96
installing 95
preserving 99
removing 94
wiping 98
Print Layout tab
changing document type 38
duplexing 38
Print Properties
I Want To menu 38
Options menu 39
Paper Setup tab 38
Print Layout tab 38
Quality/Copies tab 38
Save Settings menu 39
using 38
print quality, improving 98
print troubleshooting 104
improving print quality 98
partial document or photo
prints 107
poor text and graphic quality 105
poor quality at edges of
page 106
printer does not print or
respond 106
print speed is slow 106
printer software
reinstalling 125
removing 125
using 33
printer status 37
printing 50
banner 53
borderless photos 63
cards 50
collated copies 50, 67, 68
envelopes 51
greeting cards 50
index cards 50
last page first 52
multiple pages on one sheet
(N-up) 51
photos 59, 63
photos from PictBridge-enabled
camera 58
postcards 50
reverse page order 52
transparencies 52
using DPOF settings 60
Productivity Suite buttons
Attach to E-mail 34
Copy 34
Fax 34
Maintain/Troubleshoot 34
Manage Documents 33
Manage Photos 33
Online Tutorial 34
Scan 34
Scan & Edit Text (OCR) 34
Scan to PDF 34
Tips 34
using 33
Visit Us Online 34
Web site 34
Productivity Suite, using 33
publications
finding 11
Q
Quality /Copies tab 38
Quick Dial buttons, using 83
R
rear access door 22
receiving a fax
automatically 78
fax forwarding 85
manually 79
using an answering machine 79
recycling 100
Lexmark products 100
WEEE statement 128
reducing an image using the control
panel 70
removing print cartridges 94
repeating an image 67
reports, fax activity 88
reverse page order 52
ring patterns, setting 85
S
safety information 2
Saved Images tab
Open With section 36
Photo Prints section 36
Preview section 36
Productivity Tools section 37
Scan
menu 27
section 35
Scan & Edit Text (OCR) button 34
Scan button 34
Scan to PDF button 34
scan troubleshooting 109
cannot scan to application 110
cannot scan to printer over
network 110
partial document or photo
scans 110
scanner does not respond 109
scanning takes too long or freezes
computer 109
scan was not successful 110
scanner glass
cleaning 99
loading documents 48
scanner unit 22
scanner unit does not close 107
scanning
customizing settings 27
editing images 75
from magazines and
newspapers 75
multiple pages using the ADF 71
multiple pages using scanner
glass 71
over a network 75
to an application 72
to computer 75
to e-mail using the control
panel 73
to e-mail using the computer 74
using the control panel 73
Scanning & Copying tab
Copy section 36
Preview section 36
Productivity Tools section 36
Scan section 35
using 35
scrapbook page, creating 64
sepia warning error 125
setup troubleshooting 101
incorrect language appears on
display 101
page does not print 101
power button is not lit 101
software does not install 101
shared printing
peer-to-peer method 90

135
point-and-print method 90
slide show, viewing 60
software
  All-In-One Center 34
  Fax Setup Utility 40
  Fast Pics 40
  Photo Editor 40
  Print Properties 38
  Productivity Suite 33
  Solution Center 37
using 33
software does not install 101
Solution Center
  Advanced tab 38
  Contact Information tab 38
  How To tab 37
  Maintenance tab 38
  opening 37
  Printer Status 37
  Troubleshooting tab 38
using 37
speed dial
  adding to list 80
  setting up 80
  using 81
supplies, ordering 100

temporary files 124
text captions, adding 65
Tips button 34
top cover 21
transferring digital photos
  from memory cards 57
  from flash drives 57
transparencies
  loading 45
  printing 52
troubleshooting
  copy 107
  error messages 121
  fax 110
  incorrect language appears on the display 101
  jams and misfeeds 117
memory card 120
network 116
print 104
scan 109
setup 101
troubleshooting, copy
  copier does not respond 107
  partial document or photo copies 108
  poor copy quality 108
scanning unit does not close 107
troubleshooting, error messages
  alignment error 123
  card format 124
  carrier jam 122
  cartridge error 121
  cartridge missing 123
  DPOF error: no images found 124
  DPOF error: photo larger than paper size 125
  error 2200 122
  low ink 121
  no computer 125
  paper jam 121
  paper out 123
  photo mode: no images found 124
  photo mode: problem reading memory card 124
  photo mode: second memory card detected 124
  sepia warning 125
~filename.jpg file appears 124
troubleshooting, fax
  cannot send or receive fax 110
  can send but not receive fax 112
  can receive but not send fax 113
  error message: fax error 115
  error message: fax mode unsupported 115
  printer received blank page 114
  received fax has poor print quality 114
troubleshooting, jams and misfeeds 117
  banner jams 119
  paper jam in ADF 118
  paper jam in printer 117
  paper or specialty media misfeeds 118
  printer does not feed paper, envelopes, or specialty media 119
  troubleshooting, print
    improving print quality 98
    partial document or photo prints 107
    poor text and graphic quality 105
    poor quality at edges of page 106
  printer does not print or respond 106
  print speed is slow 106
troubleshooting, scan
  cannot scan to application 110
  cannot scan to printer over network 110
  partial document or photo scans 110
  scanner is not responding 109
  scanning takes too long or freezes computer 109
  scan was not successful 110
troubleshooting, setup 101
  incorrect language appears on display 101
  page does not print 101
  power button is not lit 101
  software does not install 101
  Troubleshooting tab 38

U
  unwanted faxes, blocking 86
USB port 22

W
  Web site button 34
  finding 12

~
  ~filename.jpg file appears error 124